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Foreword
This foreword contains general safety-related information, describes the symbols and 
conventions used in the documentation, and provides regulatory compliance information. It also 
describes potential hazards and associated warnings for the system, and the precautions that 
should be taken to minimize the hazards. In addition to this foreword, refer to the Site Planning 
Guide for site requirements, including mains supply, source exhaust, ventilation, compressed air, 
nitrogen and the roughing pump.

General Safety Information
Before operating any instrument, become familiar with its operation and with the potential 
hazards. To prevent personal injury or instrument damage, read, understand, and obey all safety 
precautions. Warnings in this document and labels on the mass spectrometer are shown with 
international symbols. Failure to heed these warnings could result in serious injury.

This safety information is intended to supplement federal, state or provincial, and local 
environmental health and safety (EHS) regulations. The information provided covers instrument-
related safety with regard to the operation of the mass spectrometer. It does not cover every 
safety procedure that should be practised. Ultimately, you and your organization are responsible 
for compliance with federal, state or provincial, and local EHS regulations and for maintaining a 
safe laboratory environment.

For more information, refer to the appropriate laboratory reference material and standard 
operating procedures.

Symbols and Conventions
The following conventions are used throughout the guide.

DANGER! Danger signifies an action which leads to severe injury or death.

WARNING! Personal Injury Hazard: A warning indicates an operation that could 
cause personal injury if precautions are not followed.

WARNING! Electric Shock Hazard: This symbol indicates a warning of electrical 
shock hazard. Read the warning and follow all precautions before performing any 
operation described in the guide. Failure to do so can result in serious injury.

WARNING! Burn Hazard: This symbol indicates a warning of potential burns 
from hot surfaces. Read the warning and follow all precautions before performing 
any operation described in the guide. Failure to do so can result in serious injury.
System User Guide
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Foreword
Caution: A caution indicates an operation that could cause damage to the instrument or 
loss of data if precautions are not followed.

Qualified Personnel
After installing the system, the FSE (Field Service Employee) uses the Customer Familiarization 
Checklist to train the customer on system operation, cleaning, and basic maintenance. Only 
qualified AB SCIEX personnel shall install and service the equipment. Only personnel qualified 
by AB SCIEX shall operate and maintain the equipment. Contact an AB SCIEX FSE for more 
information.

Equipment Use and Modification
Use the system indoors in a laboratory that complies with the environmental conditions 
recommended in the system Site Planning Guide. If the system is used in an environment or in a 
manner not prescribed by AB SCIEX, the protection provided by the equipment can be impaired.

Unauthorized modification or operation of the system may cause personal injury and equipment 
damage, and may void the warranty. Erroneous data may be generated if operating the 
instrument while exceeding the recommended environmental conditions or operating with 
unauthorized modifications. Contact an AB SCIEX representative for more information on 
servicing the instrument.

WARNING! Biohazard: This symbol indicates a warning of biohazardous 
materials. Read the warning and follow all precautions before performing any 
operation described in the guide. Failure to do so can result in serious injury.

Tip! Provides useful information that helps apply the techniques and procedures in 
the text for a specific need, and provides shortcuts, but is not essential to the completion 
of a procedure.

i

Note: A note emphasizes significant information in a procedure or description.
4500 Series of Instruments
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Foreword
Shipping Labels

Regulatory Compliance
This system complies with the standards and regulations listed in this section. Applicable labels 
have been affixed to the system.

Australia and New Zealand
• Electromagnetic Interference—AS/NZ CISPR 11 (Class A)

• Safety—AS/NZ 61010-1

Canada
• Electromagnetic Interference—CAN/CSA CISPR11. This ISM device complies 

with Canadian ICES-001.

Table 1-1 Labels on the Crate

External Labels Definition Action

 
or

TIP N TELL

Blue beads in the arrow 
indicate that the container was 
tipped or mishandled.

Write on the Bill of Lading and 
check for damage. Any claims 
for tipping require a notation.
System User Guide
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Foreword
• Safety—CAN/CSA C22.2 No. 61010-1, and CAN/CSA C22.2 No. 61010-2-061

Europe
• Electromagnetic Compatibility—EN 55011 (Class A), EN 61326-1

• Safety—EN 61010-1, EN 61010-2-061

• WEEE—2002/96/EEC

United States
• Electromagnetic Interference, FCC Part 15, Class A—This equipment has been 

tested and found to comply with the limits for a Class A digital device, pursuant to 
Part 15 of the FCC (Federal Communications Commission Compliance) Rules. 
These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not 
installed and used in accordance with the operator’s manual, can cause harmful 
interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case you will be required to 
correct the interference, at your own expense. Changes or modifications not 
expressly approved by the manufacturer could void your authority to operate the 
equipment.

• Safety—UL 61010-1, IEC 61010-2-061

International
• Electromagnetic Compatibility—IEC 61326-1, IEC CISPR 11 Class A

• Safety—IEC 61010-1, IEC 61010-2-061

For more information, see the Declaration of Conformance included with the system.

Symbols and Labels on the Mass Spectrometer
Table 1-2 Labels on the Mass Spectrometer

External Labels Definition
WARNING: NO USER SERVICEABLE PARTS 
INSIDE. REFER SERVICING TO QUALIFIED 
PERSONNEL.

EN61326—1:2006 CLASS A, GROUP 1, ISM 
EQUIPMENT
4500 Series of Instruments
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Foreword
This ISM device complies with Canadian ICES-001. 
Cet appareil ISM est conforme à la norme NMB-001 
du Canada.

FCC Compliance. This device complies with Part 15 
of the FCC Rules. Operation is subject to the 
following conditions: (1) this device may not cause 
harmful interference, and (2) this device must accept 
any interference received, including interference that 
may cause undesired operation.

0211-3199

Do not dispose of equipment as unsorted municipal 
waste (WEEE).

FOR RESEARCH USE ONLY. NOT FOR USE 
IN DIAGNOSTIC PROCEDURES.

This instrument is for research use only. It is not 
intended for use in diagnostic procedures.

Caution, see accompanying documents. 

Minimum of 6 persons required to safely lift this 
equipment

WARNING: Hot Surface Hazard.

Operator Guide

Follow operating instructions (mandatory)

Alternating Current

A Amperes (current)

Table 1-2 Labels on the Mass Spectrometer (Continued)

External Labels Definition
System User Guide
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Foreword
Occupational Health and Safety Symbols
This section describes some occupational health and safety symbols found in the laboratory 
environment.

High voltage. Electrical Shock Hazard

On (Mains supply)

Off (Mains supply)

Protective Earth (ground)

V Volts (voltage)

V-A Volts - Amperes (power)

W Watts (power)

Table 1-3 Chemical Hazard Symbols 

Safety Symbol Description
Biohazard

Corrosive or Caustic Chemical Hazard

Explosion Hazard 

Oxidizing Chemical Hazard

Poison Hazard

Reactive Chemical Hazard

Table 1-2 Labels on the Mass Spectrometer (Continued)

External Labels Definition
4500 Series of Instruments
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Foreword
Toxic Chemical Hazard

Table 1-4 Mechanical Hazard Symbols 

Safety Symbol Description
Automated Machinery Hazard

Crushing Hazard — From Above

Crushing Hazard — From Side

Fire Hazard

Hot Surface Hazard

Laser Radiation Hazard

Lifting Hazard

Magnetic Hazard

Puncture Hazard

Table 1-5 Pressurized Gas Hazard Warning Symbols 

Safety Symbol Description

Pressurized Gas Hazard

Table 1-3 Chemical Hazard Symbols  (Continued)

Safety Symbol Description
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Foreword
Mains Supply

The total combined system (instrument and roughing pump) power consumption is 2200 VA (50 
or 60 Hz) at 230 VAC. 

An external line transformer is not needed for the instrument, optional bench, or roughing pump.

Caution: Do not unpack or connect any components. The AB SCIEX FSE will unpack, 
connect, and configure the system for the proper operating voltage.

For information on system electrical specifications, refer to the Site Planning Guide.

Protective Conductor

The mains supply should include a correctly installed protective earth conductor that must be 
installed or checked by a qualified electrician before connecting the instrument.

Do not intentionally interrupt the protective conductor. Any interruption of the protective 
conductor is likely to make the installation dangerous.

Laboratory Ventilation
The venting of fumes and disposal of waste must be in accordance with all federal, state, 
provincial, and local health and safety regulations. The instrument shall be used indoors in a 
laboratory that complies with the environmental conditions recommended in the Site Planning 
Guide for the instrument. The source exhaust system must be vented either to an external fume 
hood or to an external exhaust system as recommended in the Site Planning Guide for the 
instrument.

Environmental Conditions
Use qualified personnel for the installation of electrical mains, heating, ventilation, and plumbing 
supplies and fixtures. Make sure that all installations follow local bylaws and biohazard 
regulations. For more information about the required environmental conditions for the system, 
refer to the Site Planning Guide for the instrument.

WARNING! Electrical Shock Hazard: Use only qualified personnel for the 
installation of all electrical supplies and fixtures, and make sure that all 
installations adhere to local regulations.

DANGER! Explosion Hazard: The instrument is not designed for operation in an 
explosive environment. Do not operate the instrument in an environment 
containing explosive gases.
4500 Series of Instruments
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Foreword
Instrument Disposal (Waste Electrical and 
Electronic Equipment)
Do not dispose of system components or subassemblies, including computer parts, as unsorted 
municipal waste. Follow local municipal waste ordinances for proper disposal provisions to 
reduce the environmental impact of WEEE (waste, electrical, and electronic equipment). To 
make sure that you safely dispose of this equipment, contact an FSE for instructions. 

European Union customers: Contact a local AB SCIEX Customer Service office for 
complimentary equipment pick-up and recycling.

WARNING! Asphyxiation Hazard: The use of instruments without adequate 
ventilation to outside air may constitute a health hazard. In addition, certain 
procedures required during the operation of the instrument may cause gases to 
be discharged into the exhaust stream; under these conditions, inadequate 
ventilation may result in serious injury. Take extreme care to vent exhaust gases 
properly.

WARNING! Toxic Chemical Hazard: Make sure the mass spectrometer system is 
connected to the local exhaust system and ducted to control hazardous 
emissions. The mass spectrometer system should only be used in a well-
ventilated laboratory environment in compliance with local regulations and with 
appropriate air exchange for the work performed.

Note: In the USA, OSHA 29 CFR Part 1910-1450 requires 4 to12 air changes per hour 
in laboratories.

WARNING! Biohazard: This instrument or any part is not intended to act as a 
biological containment safety cabinet. For biohazardous material use, always 
apply local regulations for hazard assessment, control, and handling.
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2
System Information
The 4500 series of instruments are intended for the qualitative and quantitative analysis of 
chemical species. The system includes a mass spectrometer, a Turbo V™ ion source, a 
computer, and the Analyst® software.

Theory of Operation
Mass spectrometry measures the mass-to-charge ratio of ions to identify unknown compounds, 
to quantify known compounds, and to provide information about the structural and chemical 
properties of molecules. 

The 4500 series of instruments have a series of quadrupole filters that transmit ions according to 
their mass-to-charge (m/z) value. The first quadrupole in this series is the QJet Ion Guide located 
between the orifice plate and Q0. The QJet Ion Guide does not filter ions, but focuses them 
before they enter Q0. By prefocusing the larger ion flux created by the wider orifice, the QJet Ion 
Guide increases instrument sensitivity and improves the signal-to-noise ratio. In Q0 the ions are 
again focused before passing into Q1.

Q1 is a filtering quadrupole that sorts the ions before they enter Q2. Q2 is a collision cell in which 
an ions internal energy is increased though collisions with gas molecules to the point that 
molecular bonds break creating product ions. This technique allows users to design experiments 
that measure the m/z of product ions to determine the composition of the parent ions. 

After passing through Q2 the ions enter Q3 for additional filtering, and then enter the detector. In 
the detector, the ions create a current that is converted into a voltage pulse. The voltage pulses 
leaving the detector are directly proportional to the quantity of ions entering the detector. The 
instrument monitors these voltage pulses and converts the information into a signal. The signal 
represents the ion intensity for a particular m/z value and the instrument displays this formation 
as a mass spectrum. 

Data Handling
The Analyst software requires a computer running the Windows operating system. The computer 
with the associated system software works with the system controller and associated firmware to 
control the instrument and data acquisition. When operating the instrument, the acquired data is 
sent to the Analyst software where it can be displayed as either full mass spectra, intensity of 
single or multiple ions versus time, or total ion current versus time.

System Overview
Figure 2-1 Front View shows a system with a syringe pump, Turbo V ion source, a diverter valve, 
and the optional NanoSpray® ion source monitors.
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System Information
Figure 2-2 Rear and Side Views on page 19 shows the location of the instrument connections, 
including the locations of the reset and vent buttons and the instrument switch.

Figure 2-1 Front View

Item Description For more information refer to...
1 Instrument panel symbols Table 2-1 on page 20.

2 Nanospray ion source 
monitors (optional)

NanoSpray® Ion Source Operator Guide located on the 
DVD that comes with the ion source.

3 Syringe pump Adjust the Integrated Syringe Pump Position on 
page 22.

4 Turbo V ion source Turbo V™ Ion Source User Reference

5 Diverter valve If the optional DuoSpray™ ion source is installed, then 
the diverter valve is replaced with the DuoSpray valve. 
The diverter valve is installed below the DuoSpray 
valve. Refer to Configure the Integrated Syringe Pump 
on page 25.

For information about the DuoSpray ion source, refer to 
the DuoSpray™ Ion Source Operator Guide located on 
the DVD that comes with the ion source.

A B

A B

1

3

5

4

2
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System Information
Figure 2-2 Rear and Side Views 

Item Description For more information...
1 Roughing pump vacuum connection Contact an AB SCIEX FSE.

2 Nitrogen gas supply (Curtain Gas™ 
supply, CAD gas)

Contact an AB SCIEX FSE.

3 Source exhaust supply Contact an AB SCIEX FSE.

4 Source communication connection Contact an AB SCIEX FSE.

5 Instrument reset button Refer to Reset the System on page 21.

6 Mains supply connection Refer to Turn on the System on page 20 or 
Shut Down the System on page 21.

7 Instrument switch

(Up = On; Down = Off)

Refer to Turn on the System on page 20 or 
Shut Down the System on page 21.

8 Aux I/O connection Refer to the Peripheral Devices Setup Guide.

9 Ethernet connection (connects the 
instrument and the computer)

Contact an AB SCIEX FSE.

10 Instrument vent (shutdown) button Refer to Turn on the System on page 20 or 
Shut Down the System on page 21.

11 Source exhaust waste (to waste 
bottle)

Contact an AB SCIEX FSE.

AUX. I/O

VENT
R
E
S
E
T

75

1
2

3

12
11

9

6

8

4

10
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System Information
Instrument Panel Symbols
Table 2-1 shows the instrument status LEDs. 

After the instrument is turned on, all five LEDs illuminate. The power LED remains lit. The other 
four LEDs flash for two seconds and then turn off. The vacuum LED starts flashing. After the 
correct vacuum has been achieved this LED remains lit.

Turn on the System

Before the system is turned on, make sure the site requirements specified in the Site Planning 
Guide are met. This includes information on the mains supply and connections, source exhaust, 
compressed air, nitrogen, roughing pump, ventilation, exhaust, and site clearance.

1. Make sure there is clear access to the power cord. The power cord must be 
accessible in order to disconnect the instrument from the AC Mains.

2. Make sure the 4 L drain bottle is connected to the Exhaust Waste connection on the 
rear of the instrument and to the laboratory ventilation system.

12 Air supply (Gas1/Gas2) Contact an AB SCIEX FSE.

Table 2-1 Instrument Panel Symbols

Instrument LEDs Color Name Description
Green Power Lit when the instrument is powered up.

Green Vacuum Lit when the correct vacuum has been 
achieved; and flashing if the vacuum is 
not at the correct vacuum (during 
pumpdown and venting.)

Green Ready Lit when the instrument is in the Ready 
state. Instrument must be in the Ready 
state to operate.

Blue Scanning Flashing when the instrument is acquiring 
data.

Red Fault Lit when the instrument encounters a 
system fault.

WARNING! Personal Injury Hazard. Risk of personal injury or instrument 
damage. If the system must be moved, contact a Field Service Employee.

Note: Before operating the instrument, read the safety information in the Foreword.

Figure 2-2 Rear and Side Views  (Continued)

Item Description For more information...
4500 Series of Instruments

20 of 142

System User Guide

  Document Number: D5030863 A



System Information
3. Make sure that the mains supply cable is plugged in to the instrument.

4. Make sure the instrument and roughing pump mains supply cable are plugged into 
the 200 to 240 V electrical mains supply.

5. Make sure that the Ethernet cable is connected to both the instrument and the 
computer.

6. Turn on the roughing pump. The mains switch is located beside the mains supply 
input connection on the roughing pump.

7. Wait 5 minutes, then turn on the instrument switch. 

8. Turn on the computer, if it was turned off.

9. Start the software.

Reset the System
• Press and hold the Reset button for 5 seconds. 

An audible click is heard when the relay activates. After approximately three 
minutes, the instrument should reach operating pressure.

Shut Down the System
1. Complete or stop any ongoing scans. For more information, refer to Stop Sample 

Acquisition on page 61.

2. Shut off the sample flow to the instrument.

Caution: Potential Instrument Damage: Shut off the sample flow before the 
instrument is shut down.

3. In the Analyst software, deactivate the hardware profile, if active.

4. Close the software.

5. Press and hold the Vent button for three seconds. 

The turbo pump will spin down gradually.

6. Wait 15 minutes.

7. Turn off the roughing pump. 

The mains switch is located beside the mains supply input connection on the 
roughing pump.

8. Wait 15 minutes, then turn off the instrument switch.

9. Unplug the mains supply cable from the bulkhead on the left side of the instrument.

10. Unplug the roughing pump mains supply cable from the electrical mains supply.

Note: If the switch is already on, turn it off and then on.
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System Information
Edit the Hardware Profile for the Integrated 
Syringe Pump
Make sure the syringe pump is seated properly to avoid damaging the syringe. For more 
information about creating and editing hardware profiles, refer to Create a Hardware Profile on 
page 31. 

1. In the Navigation bar, under Configure, double-click Hardware Configuration.

2. Create or edit the hardware profile containing the instrument.

3. In the Configuration tab (Figure 2-3 Configuration tab), select Use integrated 
syringe pump.

4. Click OK.

Figure 2-3 Configuration tab

5. Activate the hardware profile.

Adjust the Integrated Syringe Pump Position
1. Press the button on the right side of the syringe pump to lower the base and then 

insert the syringe as shown in Figure 2-4 Lowering the syringe.

Make sure that the end of the syringe is flush against the base and that the shaft of 
the syringe rests in the cutout.
4500 Series of Instruments
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System Information
2. Adjust the post (Figure 2-5 Safety stop) so that it triggers the automatic syringe stop 
before the syringe plunger hits the bottom of the glass syringe.

Figure 2-4 Lowering the syringe

Item Description
1 Syringe plunger.

2 Release button. Press to raise or lower the base.

Figure 2-5 Safety stop 

Item Description
1 Automatic syringe stop. After the post hits the automatic syringe stop, the 

syringe pump stops.

2

1

1

2

3
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System Information
3. Turn the side screws as shown in Figure 2-6 Syringe pump to secure the syringe.

Figure 2-6 Syringe pump

4. On the instrument, press the button on the right side of the syringe pump (Figure 2-7 
Syringe pump LED) to start the flow.

The light next to the button illuminates when the syringe pump is in use.

2 Post. Adjust the height to prevent the syringe plunger from hitting the 
syringe during sample infusion.

3 Post lock screw. Tighten the screw after the height of the post is adjusted.

Tip! The syringe pump can also be started using the Analyst software in 
Manual Tuning mode.

Figure 2-5 Safety stop  (Continued)

Item Description
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System Information
Configure the Integrated Syringe Pump
1. In the Navigation bar, under Acquire, double-click Build Acquisition Methods.

2. In the Acquisition method pane, click the Syringe Pump icon.

The Syringe Pump method properties tab opens in the Acquisition Method Editor 
pane.

3. In the Syringe Diameter (mm) field, type the syringe diameter.

4. In the Flow Rate field, type the flow rate.

5. In the Unit list, select the units of flow.

6. Save the file. 

Configure the Diverter Valve
The diverter valve is a two position, 6 port valve. If the valve is in Position A (Figure 2-9 Diverter 
valve—injector mode position A), the sample flows through the external loop. When the valve is 
switched to Position B (Figure 2-10 Diverter valve—injector mode position B), the sample is 
injected. For more information about creating and editing hardware profiles, refer to Create a 
Hardware Profile on page 31.

1. In the Navigation bar, under Configure, double-click Hardware Configuration.

2. Create or edit the hardware profile containing the instrument.

3. In the Configuration tab (Figure 2-8 Configuration tab), select Use integrated 
injector/diverter valve. 

Figure 2-7 Syringe pump LED

Item Description
1 Syringe pump on/off button

2 Syringe pump status LED

A B

2

1
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System Information
4. Click OK.

Figure 2-8 Configuration tab

5. Activate the hardware profile.

Plumb the Diverter Valve
The diverter valve should be plumbed for both injector and diverter modes.

Plumb the Diverter Valve in Injector Mode
The diverter valve is a two position, 6 port valve. If you put the valve in Position A (Figure 2-9), 
the sample flows through the external loop. When you switch the valve to Position B 
(Figure 2-10), the sample is injected.
4500 Series of Instruments
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System Information
Figure 2-9 Diverter valve—injector mode position A 

Item Description

1 Sample in

2 Waste out

3 Sample loop

4 Mobile phase in

5 To column

1 4

6 5

2 3

1

2

3

5

4
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System Information
Figure 2-10 Diverter valve—injector mode position B 

Item Sample in

1 Sample in

2 Waste out

3 Sample loop

4 Mobile phase in

5 To column

1 4

6 5

2 3

1

2

3

4

5
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System Information
Plumb the Diverter Valve in Diverter Mode

Figure 2-11 Diverter valve—diverter mode position A 

Item Description

1 Sample in

2 Waste out

3 To column

1 4

6 5

2 3

3

2

1
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System Information
Instrument Safe Fluids
The following fluids can safely be used with the instrument:

• Methanol (0 to 100%)

• Acetonitrile (0 to 100%)

• Water 

• Formic acid (0 to 1%)

• Ammonium acetate (0 to 1%)

Figure 2-12 Diverter valve—diverter mode position B 

Item Sample in

1 Sample in

2 To column

3 Waste out

Note: This list is not complete. Do not use any other fluid until confirmation is received 
from AB SCIEX that it will not present a hazard.

3

4

5
6

1

2

1 4

6 5

2 3

2

1

3

4500 Series of Instruments

30 of 142

System User Guide

  Document Number: D5030863 A



3
Hardware Profiles and Projects
Hardware Profiles
A hardware profile tells the software what instrument and devices  to use, and how the 
instrument and the devices are configured and connected to  the computer.

Each hardware profile must include a mass spectrometer. Before creating an acquisition method, 
make sure that all devices used in the method are included in the hardware profile. In the 
configuration options for the mass spectrometer, ensure that the syring pump is enabled if it will 
be used during acquisition.

The devices configured in the active hardware profile and selected in the Add/Remove Device 
Method dialog appear as icons in the Acquisition Method Browser pane. Only devices included in 
the active hardware profile can be used to create acquisition methods. 

For information about configuring devices, refer to the Peripheral Devices Setup Guide. For a list 
of the supported devices, refer to the Software Installation Guide for the Analyst® software.

Create a Hardware Profile
The user can create multiple hardware profiles, but only one profile can be active at any time.

1. In the Navigation Bar, under Configure, double-click Hardware Configuration.

Figure 3-1 Hardware Configuration Editor dialog

2. In the Hardware Configuration Editor dialog, click New Profile.
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Hardware Profiles and Projects
Figure 3-2 Create New Hardware Profile

3. In the Profile Name field, type a name.

4. Click Add Device.

In the Available Devices dialog, in the Device Type field, Mass Spectrometer is the 
preset value.
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Hardware Profiles and Projects
Figure 3-3 Available Devices dialog

5. In the Devices list, select the instrument.

6. Click OK.

7. In the Devices in current profile list, select the instrument.

8. Click Setup Device.

9. Select the features in the Configuration tab and Communication tab as required.

10. Click OK to return to the Create New Hardware Profile dialog.

11. Click Add Device

12. Add and configure each device that is used with the instrument. Refer to Add 
Devices to a Hardware Profile on page 34.

13. In the Create New Hardware Profile dialog, click OK.

14. In the Hardware Configuration Editor, click the hardware profile.

15. Click Activate Profile.

The check mark turns green. If a red x is shown, then there is an issue with the 
hardware profile activation. For more information, refer to Troubleshooting Hardware 
Profile Activation.

16. Click Close.

Tip! A hardware profile does not have to be deactivated before activating 
another. Click a hardware profile and then click Activate Profile. The other 
profile is deactivated automatically.
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Hardware Profiles and Projects
Add Devices to a Hardware Profile
Devices must be configured to enable the software to communicate with them. 

When the software is installed, the driver required for each device is also installed. After the 
devices are physically connected to the computer, configure the device.

1. Open the Hardware Configuration Editor.

2. In the Hardware Profiles list, deactivate the hardware profile.

3. Click Edit Profile.

4. Click Add Device.

5. In the Available Devices dialog, in the Device Type list, select the device.

6. Click OK.

Figure 3-4 Available Devices dialog

7. In the Devices in current profile list, select the device.

8. Click Setup Device.

A dialog containing configuration values for the device opens.

9. In the Communication tab, in the Alias field, type a name or other identifier. 
(Optional)

• If the device uses Serial Port as a communication interface, in the COM Port 
Number list, select the COM port that the device is connected to.

• If the device uses Ethernet as a communication interface, type the IP address 
assigned to the device by the administrator or use the corresponding host 
name for the address.

Note: For devices using serial communication, make sure that the serial 
port selected matches the serial port to which the device is physically 
connected. If a serial expansion cable is used, then the number selected in 
the profile is the number on the cable plus two.

Note: The Alias field may also be referred to as the Name box and may be 
found on another tab under Alias.
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Hardware Profiles and Projects
• If the device uses a GPIB board as a communication interface, do not change 
the settings for the GPIB board.

The rest of the preset values for the device are likely appropriate; do not change 
them. For information about the Configuration and Communication tabs, refer to the 
Help.

10. To restore the device preset values, in the Communication tab, click Set Defaults.

11. To save the configuration, click OK.

12. Repeat steps 4 to 9 for each device.

13. In the Create New Hardware Profile dialog, click OK.

14. To activate the hardware profile, in the Hardware Configuration Editor, click the 
hardware profile.

15. Click Activate Profile.

The check mark turns green. If a red x is shown, then there is an issue with the 
hardware profile activation. For more information, refer to Troubleshooting Hardware 
Profile Activation.

16. Click Close.

Troubleshooting Hardware Profile Activation
If a hardware profile fails to become active, a dialog appears indicating which device in the profile 
failed. A failed profile may be due to communications errors.

1. Read the error message generated. Depending on the message, there may be an 
issue with a device or how the communication is set up.

2. Verify that the device has power and is turned on.

3. Verify that the COM port assigned to the device is correct.

4. Verify that the communication settings with the device (for example, dip switch 
settings) are set correctly and match the settings in the Communication tab.

5. Turn off the device.

6. Wait 10 seconds

7. Turn on the device. 

Wait until all device power-up activities are complete before trying to activate the 
hardware profile again. Some devices may require 30 seconds or more to complete 
the power-up activities.

8. Activate the hardware profile.

Tip! A hardware profile does not have to be deactivated before activating 
another hardware profile. Click a hardware profile and then click Activate 
Profile. The other profile is deactivated automatically.

Tip! On computers with two built-in serial ports, the first port on the serial 
port expansion card is usually COM3, even though the cable indicates P1.
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Hardware Profiles and Projects
9. If the issue persists, delete the failing profile and then create a new one.

10. If the issue persists, contact technical support.

Create Projects and Subprojects
To use a subproject structure within a project, create the subproject structure when the project is 
created.

1. Click Tools > Project > Create Project.

2. In the Project name field, type a project name.

3. (Optional) To use subprojects, select the required folders and then use the arrow 
buttons to move them to the Subproject folders list.

Figure 3-5 Create new Project/Subproject dialog

4. (If subprojects are used.) In the Subproject name field, type a name for the first 
subproject or use the existing date.

5. To use this project and subproject folder organization for all new projects, select the 
Set configuration as default for new projects check box. 

All new projects are created with this folder configuration.

6. Click OK.
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Hardware Profiles and Projects
Create a Subproject
Subprojects can only be created in a project that has an existing subproject structure.

1. On the Project toolbar, in the Project list, select the project.

2. Click Tools > Project > Create Subproject.

3. In the Subproject name box, type a name for the subproject or use the existing 
date.

4. Click OK.

Copy a Subproject
The user can copy a subproject from another project that has existing subprojects. If the copied 
subprojects contain folders that also exist in the project folder, then the software uses the project 
level folders

1. Click Tools > Project > Copy Subproject. 

2. In the Copy Subproject dialog, click Browse to navigate to the subproject source.

3. Click OK.

4. In the Source Subproject list, select the subproject.

5. Click Browse to navigate to the subproject destination.

6. In the Target Subproject field, type the name.

7. Click OK.

8. Do one of the following:

• To copy all folders and files from the Subproject Source into the Subproject 
Destination, select the Copy Contents check box.

• To copy only the folders in the same structure into the Subproject 
Destination, make sure that the Copy Contents check box is cleared.

9. Click Copy.

Installed Project Folders
Three project folders are installed with the software: API Instrument, Default, and Example.

API Instrument Folder

The API Instrument folder is unique and very important to the correct functioning of the 
instrument. The API Instrument folder contains the information required for tuning and calibrating 
the instrument. This information includes parameter settings files, reference files, instrument data 
files that contain calibration and resolution information, and the acquisition methods used during 
automatic tuning. The API Instrument folder also contains data files for manual tuning runs that 
were performed using the Start button rather than the Acquire button. These data files are saved 
automatically in the API Instrument folder in the Tuning Cache folder and named with the date 
and time they were created. The Tuning Cache is automatically cleared periodically.
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Default Folder

The Default folder contains folders that are present in new projects and serves as a template for 
new projects.

Example Folder

The Example folder contains sample methods and data files. Users can practice working with the 
Explore or Quantitate modes using the example data files. The example files are sorted into 
subfolders by instrument type and application area.

Back up the API Instrument Folder
Back up the API Instrument folder regularly and after routine maintenance has been performed.

1. Copy the API Instrument folder, paste it to a different location, preferably to another 
computer, and then rename the folder. Use the date and an instrument reference if 
there is more than one instrument when folder is named; for example, API 
Instrument__4000QTRAP3_010107 

2. To recover the folder, rename the current API Instrument folder, and then copy the 
backup into the Projects folder and then change its name back to API Instrument.

Table 3-1 Icons on the Toolbar

Icon Name Function
New Subproject Creates a subproject. Subprojects can only be created later in the 

process if the project was originally created with subprojects.

Copy Subproject Copies a Subproject folder.

Subprojects can be copied only from another project that has 
existing subprojects. If the same folders exist at both the project 
and subproject levels, the software uses the project level folders.
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Instrument Tuning and Calibrating 
Run the Verify instrument performance option weekly or after the instrument is cleaned to confirm 
that the system is working properly. In general, the calibration and resolution for quadrupole are 
fine for 3 to 6 months unless the system loses vacuum. For LIT (linear ion trap) systems, the 
resolution should also be fine for 3 to 6 months but the calibration should be done approximately 
monthly. If the system loses vacuum, then check the calibration and resolution before using the 
system. For more information about tuning and calibration, refer to the Advanced User Guide and 
the Manual Tuning Tutorial.

Required material
• Tuning solutions that are supplied in the Standards Chemical Kit shipped with the 

system. If needed, a new Kit can be ordered from AB SCIEX.

• 5 ml, 1 ml, and 250 µl serial gas-tight syringes.

• PEEK (red) sample tubing.

Prerequisites
• Make sure that a printer is configured.

• Make sure that the spray is stable and that the correct tuning solution is being used. 

Optimize the Instrument
The following procedure describes how to verify the performance of the instrument. For more 
information about using the other instrument performance options, refer to the Help.

1. In the Navigation Bar, under Tune and Calibrate, double-click Manual Tuning.

2. Run a calibration method and confirm that there is a stable TIC and that the peaks of 
interest are present in the spectrum.

3. In the Navigation Bar, under Tune and Calibrate, double-click Instrument 
Optimization.

4. Click Verify instrument performance.

5. Click Next.

6. Click Approved Tuning.

7. Click Next.

8. Select a Tuning Solution.

Depending on the solution selected, different modes are available.

i. Click a polarity.
ii. If available, click Q1 and Q3 in the Quad section. If available, click the 

required scan speeds.
iii. If available, click the scan speeds in the LIT section.
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Instrument Tuning and Calibrating
iv. If available, click MS/MS/MS options and then click Next.

9. If the Select a mode page opens, select Automatic and then click Next.

10. Click GO.

The Verifying or Adjusting Performance screen opens. After the process has 
completed, the Results Summary opens. For more information, refer to the Help.

11. Depending on the fields selected, the user will be prompted to change solutions for 
the various scan types and polarities.

Verify or Adjust Performance
The top left corner shows the part of the instrument that is being tuned.

Current Spectrum: This graph shows the spectrum of the current scan, the optimal scan 
selected by the software, or the scan at the current parameter value when the software results 
are viewed in interactive mode.

The Instrument Optimization Decision Plots, in the top right graph, dynamically show the intensity 
versus voltage curves of the parameters that are currently being optimized. 

Results Summary
The Results Summary, shown in Figure 4-1, is a record of any instrument settings changes that 
were made by the Instrument Optimization software. This includes the location of data files and 
instrument settings backups, as well as step-by-step changes and results during optimization. In 
addition, the Results Summary shows a verification report. This report contains a snapshot of the 
mass spectrum for each relevant mass for the scan modes being verified. The spectrum is 
labelled with the target mass, where the mass was found, mass shift, peak width, and peak 
intensity. The spectrum can be used as a visual record of peak shape or scan mode 
performance. A summary table of results follows the spectra. 

The Results Summary is saved as a document in the folder indicated at the top of the report. 
Users can print the Results Summary or open a previously saved Results Summary.
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Figure 4-1 Results Summary
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5
Basic Acquisition Methods
An acquisition method consists of experiments and periods. Use the Acquisition Method Editor to 
create a sequence of periods and experiments for the instrument and devices.

Create Acquisition Methods
Only devices configured in the active hardware profile appear in the Acquisition Method Browser 
pane. Any devices added to the hardware profile must also be added to existing acquisition 
methods. For more information about devices, refer to the Peripheral Devices Setup Guide.

1. In the Navigation Bar, under Acquire, double-click Build Acquisition Method.

2. In the Acquisition Method Properties tab, select a Synchronization Mode. 

3. Select the Auto-Equilibration check box. (Optional)

4. Enter the desired equilibration time in minutes, if Auto-Equilibration is selected.

5. In the Acquisition method pane, click the Mass Spec icon.

6. In the MS tab, select a scan type.

7. Type values in the fields as required. For more information refer to Parameters on 
page 46.

8. In the Advanced MS tab, type values in the fields as required. For more information 
refer to Parameters on page 46.

9. Click a device icon. 

10. Select the parameters for the devices as required.

11. Add any additional periods and experiments.

12. Click File > Save.

Add an Experiment
1. Right-click the period and then click Add experiment.

An experiment is added below the last experiment in the period.

2. In the Acquisition Method Editor pane, select the appropriate device or instrument 
parameters.

Add a Period 
• In the Acquisition method pane, right-click the Mass Spec icon, and then click Add 

period.

A period is added below the last period created.
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Basic Acquisition Methods
Copy an Experiment into a Period
Prerequisite: Multi-period method

• In the Acquisition method pane, press CTRL, and then drag the experiment to the 
period. 

The experiment is copied below the last experiment in the period.

Copy an Experiment within a Period
Use this procedure to add the same or similar experiments to a period if most or all of the 
parameters are the same.

• Right-click the experiment and then click Copy this experiment. 

Scan Techniques
MS: In MS scans, also referred to as single MS scans, ions are separated according to their 
mass-to-charge ratio. A single MS scan may be used to determine the molecular weight of a 
compound. Single MS scans can also be referred to as survey scans. MS scans do not provide 
any information as to the chemical make-up of the ions other than the mass-to-charge ratio. 
Perform MS/MS or MS/MS/MS scan types to obtain more information about the ions.

MS/MS: MS/MS scans are used to help identify or confirm a molecular species. In MS/MS, a 
precursor ion can be fragmented in one of two locations.

• For triple quadrupole instruments, fragmentation occurs in the collision cell.

• For LIT instruments, fragmentation can occur in the collision cell or the linear ion 
trap.

If enough energy is used, the precursor ion fragments to produce characteristic product ions.

MS/MS/MS: The LIT instrument MS/MS/MS scans go one step further than MS/MS scans. A 
fragment that is produced in the collision cell is fragmented further in the trap to give more 
structural information about the molecular ion.

Quadrupole-Mode Scan Types
Triple quadrupole instruments have high-sensitivity MRM (Multiple Reaction Monitoring) 
capabilities required for quantitation experiments. In addition, they have highly specific scan 
types such as precursor ion and neutral loss scans that allow a more advanced search to be 
performed on the components of the samples.

Q1 MS (Q1): A full scan using the first quadrupole (Q1). The ion intensity is returned for every 
mass in the scan range.

Q1 Multiple Ions (Q1 MI): A zero width scan type using the first quadrupole (Q1). The ion 
intensity is returned for the specified masses only. 

Q3 MS (Q3): A full scan using the third quadrupole (Q3). The ion intensity is returned for every 
mass in the scan range.

Q3 Multiple Ions (Q3 MI): A zero width scan type using the third quadrupole (Q3). The ion 
intensity is returned for the specified masses only.
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Basic Acquisition Methods
MRM (MRM): An MS/MS scan in which a user-selected ion is passed through the first 
quadrupole (Q1) and fragmented in the second quadrupole (Q2). The third quadrupole (Q3) is 
then used to specify which fragment ion enters the detector. This scan mode is used primarily for 
quantitation.

Product Ion (MS2): MS/MS full scan where the first quadrupole (Q1) is fixed to transmit a 
specific precursor ion and the third quadrupole (Q3) scans a defined mass range. Used to 
identify all of the products of a particular precursor ion. 

Precursor Ion (Prec): MS/MS scan where the third quadrupole (Q3) is fixed at a specified mass-
to-charge ratio to transmit a specific product ion and the first quadrupole (Q1) scans a mass 
range. Used to confirm the presence of a precursor ion or more commonly used to identify 
compounds sharing a common product ion.

Neutral Loss (NL): MS/MS scan where both the first quadrupole (Q1) and the third quadrupole 
(Q3) scan a mass range, a fixed mass apart. A response is observed if the ion chosen by the first 
analyzer fragments by losing the neutral loss (the fixed mass) specified. Used to confirm the 
presence of a precursor ion or more commonly used to identify compounds sharing a common 
neutral loss.

LIT-Mode Scan Types
The LIT-mode scans use the third quadrupole, Q3, as a linear ion trap. Ions are trapped and 
stored in the trap before being scanned out, giving increased sensitivity. In addition, MS/MS/MS 
can be performed in the linear ion trap, providing more information about the sample. 

Enhanced MS (EMS): Ions are scanned in Q1 to the linear ion trap where they are collected. 
These ions are scanned out of Q3 to produce single MS type spectra.

Enhanced Multi-Charge (EMC): This scan is similar to the EMS scan except that before 
scanning the ions out of the linear ion trap, there is a delay period in which low-charge state ions 
(primarily singly-charged ions) are allowed to preferentially escape from the linear ion trap. When 
the retained ions are scanned out, the multiply-charged ion population dominates the resulting 
spectrum.

Enhanced Product Ion (EPI): This scan type is used to obtain a high quality MS/MS spectrum 
on a specific ion. The fragmentation is done in the collision cell and thus provides the 
information-rich MS/MS spectrum typical of collisionally activated dissociation fragmentation. In 
this scan mode, the precursor ion to be fragmented is first selected in Q1 with a mass window of 
1 to 4 Da wide, filtering out all other ions. The precursor ion is fragmented by collisionally-
activated dissociation (CAD) gas in the Q2 collision cell. The fragment ions generated are 
captured in the linear ion trap and then scanned out at one of three scan speeds, depending on 
the required fragment ion resolution. 

For IDA experiments, the Product Of field is set to 30 Da by default, and this value should not be 
changed.

Enhanced Resolution (ER): This scan is similar to the EMS scan except that a small 30 Da 
mass around the precursor mass is scanned out of the linear ion trap at the slowest scan rate to 
produce a narrow window of the best-resolved spectra.

MS/MS/MS (MS3): In this scan mode, a precursor ion is selected by Q1 and fragmented with 
collisionally activated dissociation in the Q2 collision cell. The resulting product ions are all 
transmitted to the linear ion trap, where a single product ion is then isolated. The isolated ion is 
further fragmented in the linear ion trap, and the resulting product ions are scanned out of the ion 
trap at one of three scan speeds. As with any in-trap CID technique, there is a low mass cut-off 
for the second MS/MS step due to the condition that the lowest mass fragment and precursor 
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Basic Acquisition Methods
must be simultaneously stable in the trap. For the QTRAP® instruments, this means that we lose 
ions lower than 28 percent of the mass of the precursor ion when performing MS3 experiments. 
This phenomenon is often referred to as the 1/3rd cut-off rule.

Time Delayed Frag (TDF): Product ions are generated and collected in the linear ion trap. 
During the first part of the collection period, the lower mass ions are not collected in the linear ion 
trap. During the second part of the collection period, all masses over the mass range of interest 
are collected. The resulting enhanced product ion spectra are simplified compared to EPI scan 
type spectra. The nature of the spectra aids in the interpretation of the structure and 
fragmentation pathways of the molecule of interest. This scan type is not applicable to the AB 
SCIEX 4500 QTRAP and AB SCIEX 5500 QTRAP systems.

About Spectral Data Acquisition
Spectral data can be acquired in one of three modes, as shown in the following table.

Parameters
The working parameters are the set of instrument parameters currently being used. 

• Source and gas parameters (these parameters can change depending on the ion 
source used)

• Compound parameters

• Resolution parameters 

• Detector parameters

For more information about instrument parameter values and ranges, refer to Appendix B: 4500 
Series Instrument Requirements and Parameters.

Table 5-1 Spectral Data Acquisition

Mode Description
Profile The preset value is 0.1 Da. Profile data is the data generated by the 

instrument and corresponds to the intensity recorded at a series of 
evenly spaced discrete mass values. For example, for a mass range 
100 Da to 200 Da and step size 0.1, the instrument scans 99.95 to 
100.05 (records as value 100), 100.05 to 101.15 (records as value 
101)…199.95 to 200.05 (records as value 200).

Peak Hopping The preset value is 1.0 Da. Peak Hopping is a mode of operating a 
mass spectrometer in which large steps (approximately 1 Da) are 
made. It has the advantage of speed (less data steps are made) but 
with the loss of peak shape information.

Centroid The instrument scans as in Profile mode, but creates a centroid of the 
data, replacing found peaks with the intensity-weighted center of 
gravity for each peak. Centroid data has the advantage of significantly 
reducing file size. The disadvantage is that peak shape information is 
lost, and if data has been collected as a centroid it cannot be altered. It 
is recommended to use Profile mode and centroid the data post-
acquisition.
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The following figure shows the location of the parameters on the ion optics path. 

Figure 5-1 Ion optics path and parameters

Item Parameter Parameter 
Type

Use Scan Type

1 IS (Ion Transfer 
Voltage)

Source and 
gas

For the PhotoSpray® source, the IS 
parameter controls the voltage that 
transfers the ions from the primary 
ionization region towards the 
curtain plate orifice.

All

1 NC (Needle 
Current)

Source and 
gas

The NC parameter controls the 
current applied to the corona 
discharge needle in the APCI 
probe, used in the Turbo V™ 
source. The discharge ionizes 
solvent molecules, which in turn 
ionize the sample molecules.

All

1 ihe (Interface 
Heater)

Source and 
gas

The ihe parameter switches the 
interface heater on and off. Heating 
the interface helps maximize the 
ion signal and prevents 
contamination of the ion optics. 
This should always stay on. The 
button controlling the interface 
heater reads ON when the 
interface heater is on.

All

1 IHT (Interface 
Heater 
Temperature)

Source and 
gas

The IHT parameter controls the 
temperature of the NanoSpray® 
interface heater and is only 
available if the NanoSpray ion 
source and interface are installed. 

All

1 sdp Source and 
gas

The sdp parameter controls the 
selection of the DuoSpray™ ion 
source probes: TurboIonSpray 
probe or APCI probe

2

1

3

4
5678
System User Guide

Document Number: D5030863 A

4500 Series of Instruments

 47 of 142



Basic Acquisition Methods
1 DP (Declustering 
Potential)

Compound The DP parameter controls the 
voltage on the orifice, which 
controls the ability to decluster ions 
between the orifice and the 
skimmer (or for systems with a 
QJet® Ion Guide, between the 
orifice and QJet Ion Guide). It is 
used to minimize the solvent 
clusters that may remain on the 
sample ions after they enter the 
vacuum chamber, and, if required, 
to fragment ions. The higher the 
voltage, the higher the energy 
imparted to the ions. If the DP 
parameter is too high, unwanted 
fragmentation may occur.

Use the preset value and optimize 
for the compound.

All

1 CUR (Curtain 
Gas)

Source and 
gas

The CUR parameter controls the 
gas flow of the Curtain Gas™ 

interface. The Curtain Gas 
interface is located between the 
curtain plate and the orifice. It 
assists in solvent evaporation and 
prevents solvent droplets from 
entering and contaminating the ion 
optics. The gas flow should be 
maintained as high as possible 
without losing sensitivity.

All

1 IS (IonSpray 
Voltage)

Source and 
gas

The IS parameter controls the 
voltage applied to the electrode 
that ionizes the sample in the ion 
source. It depends on the polarity 
and it affects the spray stability and 
the sensitivity. This parameter can 
be compound-dependent and 
should be optimized for each 
compound.

All

1 GS1 (Gas 1) Source and 
gas

The GS1 parameter controls the 
nebulizer gas. The nebulizer gas 
helps generate small droplets of 
sample flow and affects spray 
stability and sensitivity.

All

Figure 5-1 Ion optics path and parameters (Continued)

Item Parameter Parameter 
Type

Use Scan Type
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1 GS2 (Gas 2) Source and 
gas

The GS2 parameter controls the 
auxiliary, or turbo, gas. It is used to 
help evaporate the solvent to 
produce gas phase sample ions.

All

1 TEM 
(Temperature)

Source and 
gas

The TEM parameter controls the 
temperature of the turbo gas in the 
TurboIonSpray® probe or the 
temperature of the probe in the 
heated nebulizer (or APCI) probe.

All

2 EP (Entrance 
Potential)

Compound The EP parameter controls the 
potential difference between the 
voltage on Q0 and ground. The 
entrance potential guides and 
focuses the ions through the high-
pressure Q0 region.

Use the preset value.

All

2 Q0 Trapping Compound The Q0 trapping parameter 
controls the storage of ions in the 
Q0 region. It is used to increase 
sensitivity and duty cycle by 
trapping ions in the Q0 region while 
ions are being mass-selectively 
ejected from the LIT. Use fixed fill 
time with this parameter.

Either select or clear the feature 
based on the experiment.

The recommended fixed fill time to 
use with Q0 trapping is 20 ms or 
greater.

EMS, EMC, 
EPI, ER, and 
MS/MS/MS, 

Figure 5-1 Ion optics path and parameters (Continued)

Item Parameter Parameter 
Type

Use Scan Type
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3 CAD Gas Source and 
gas

The CAD parameter controls the 
pressure of collision gas in the 
collision cell during Q3, MS/MS-
type, and LIT scans. For Q3 scans, 
the collision gas helps to focus the 
ions as they pass through the 
collision cell; the preset for the 
CAD parameter is in fixed mode. 
For MS/MS-type scans, the 
collision gas aids in fragmenting 
the precursor ions. When the 
precursor ions collide with the 
collision gas, they can dissociate to 
form product ions. For LIT scans, 
the collision gas helps to focus and 
trap ions in the LIT.

Use the preset value and optimize 
for the compound.

Q3 MI, Q3 MS, 
MRM, Prec, 
NL, EMS, ER, 
EPI, 
MS/MS/MS, 
EMC, and TDF

3 CE (Collision 
Energy)

Compound The CE parameter controls the 
potential difference between Q0 
and Q2 (collision cell). It is used 
only in MS/MS-type scans. This is 
the amount of energy that the 
precursor ions receive as they are 
accelerated into the collision cell, 
where they collide with gas 
molecules and fragment.

Use the preset value and optimize 
for the compound.

MRM, MS2, 
Prec, NL, and 
LIT

3 CES (Collision 
Energy Spread)

Compound The CES parameter, in conjunction 
with the Collision Energy (CE), 
determines which three discreet 
collision energies are applied to the 
precursor mass in an Enhanced 
Product Ion (EPI) or MS/MS/MS 
(MS3) experiment when CES is 
used. By typing a collision energy 
spread value, CES is automatically 
turned on.

Use the preset value and optimize 
for the compound.

EPI and 
MS/MS/MS

Figure 5-1 Ion optics path and parameters (Continued)

Item Parameter Parameter 
Type

Use Scan Type
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4 CXP (Collision 
Cell Exit 
Potential)

Compound The CXP parameter is only used in 
Q3 and MS/MS-type scans, where 
it transmits the ions into Q3.

Use the preset value and optimize 
for the compound.

Q3, MRM, 
MS2, Prec, 
and NL

4 TDF CE (Time 
Delayed 
Fragmentation 
Collision Energy)

Compound This is the amount of energy that 
the precursor ions receive as they 
are accelerated into Q3, where 
they collide with gas molecules and 
fragment.

Use the preset value.

TDF

5 Q3 Entry Barrier Compound The Q3 Entry Barrier parameter is 
used to transfer the ions from Q2 
into the LIT.

Use the preset value.

EMS, EMC, 
EPI, ER, and 
MS/MS/MS 

5 Q3 Empty Time Compound The Q3 Empty Time parameter 
controls the amount of time that 
singly-charged ions are removed 
from the LIT.

Use the preset value.

EMC

MS/MS/MS 
Fragmentation 
Time

Compound The MS/MS/MS Fragmentation 
Time parameter controls the 
amount of time that the excitation 
energy is applied. It is used in 
combination with the excitation 
energy to fragment the isolated 
second precursor ion.

Use the preset value.

MS/MS/MS

6 MCS (Multi-
Charge 
Separation) 
Barrier

Compound The MCS Barrier parameter 
controls the voltage used when 
eliminating the singly-charged ions 
from the LIT.

Use the preset value.

EMC

6 Q3 Cool Time Compound The Q3 Cool Time parameter 
controls the amount of time that the 
precursor ions are allowed to cool 
prior to collection of their product 
ions.

Use the preset value.

TDF

Figure 5-1 Ion optics path and parameters (Continued)

Item Parameter Parameter 
Type

Use Scan Type
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7 Fixed LIT Fill 
Time

Compound The Fixed LIT Fill Time parameter 
controls the amount of time that the 
LIT fills with ions.

Use the preset value.

EMS, EPI, 
MRM, and MS/
MS/MS

7 DFT (Dynamic 
Fill Time)

Compound DFT will dynamically calculate the 
length of time that ions are 
collected in the LIT based on the 
incoming ion signal. When DFT is 
turned on the signal is optimized to 
either increase sensitivity or 
minimize space-charging.

Either select or clear the feature 
based on the experiment.

In the Tools > Settings > Method 
Options dialog, the Dynamic Fill 
Time settings are optimized for the 
10000 Da/s scan speed. These 
settings are also suitable for other 
LIT scan speeds.

EMS, EPI, ER, 
and
MS/MS/MS

8 CEM (CEM) Detector The CEM parameter controls the 
voltage applied to the detector. The 
voltage controls the detector 
response. 

All

Figure 5-1 Ion optics path and parameters (Continued)

Item Parameter Parameter 
Type

Use Scan Type
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Basic Acquisition Methods
Acquisition Method Editor Icons
Table 5-2 Acquisition Method Editor Icons

Icon Name Function
Mass Spec Shows the MS tab in the Acquisition Method 

Editor.

Period Right-click to add an experiment, add an IDA 
Criteria Level, or delete the period.

Autosampler Opens the Autosampler Properties tab.

Syringe Pump Opens the Syringe Pump Properties tab.

Column Oven Opens the Column Oven Properties tab.

Valve Opens the Valve Properties tab.

DAD Opens the DAD Method Editor. For more 
information about the DAD, refer to Show DAD 
Data on page 78.

ADC Opens the ADC Properties tab. For more 
information about the ADC, refer to Show ADC 
Data on page 72.
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6
Batches
A batch is a collection of information about the samples. Batches tell the software the order in 
which to analyze the samples. For more information about importing batches, refer to the 
Advanced User Guide.

Set Queue Options
The queue goes one by one through the list, running each sample with the selected acquisition 
method. After all the samples have been acquired, the queue stops and the instrument goes into 
Standby mode. In Standby mode, the LC pumps are turned off and some instrument voltages are 
turned off.

The user can change the length of time the queue runs after the last acquisition has finished, 
before it puts the instrument into Standby mode. For more information about the other fields in 
the Queue Options dialog, refer to the Help.

1. In the Navigation Bar, click Configure.

2. Click Tools > Settings > Queue Options.

Figure 6-1 Queue Options dialog

3. In the Max Idle Time field, type the length of time the queue will wait after acquisition 
is completed before going into Standby mode. The preset value is 60 minutes.

4. If gas cylinders are used, adjust this time to make sure that the gas in the cylinders is 
not depleted.

5. If an LC method is used, then before the run is started, make sure that there is 
enough solvent in the reservoirs for the primary flow rate for all of the sample runs 
and the maximum idle time.
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Create and Submit a Batch
For more information about adding quantitation information to a batch, refer to the Advanced 
User Guide.

1. In the Navigation Bar, under Acquire, double-click Build Acquisition Batch.

Figure 6-2 Batch Editor

2. In the Sample tab, in the Set list, type a name.

3. Click Add Set.

4. Click Add Samples.
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Batches
Figure 6-3 Add Sample dialog

5. In the Sample name section, in the Prefix field, type a name for the samples.

6. To add incremental numbering to the end of the sample name, select the Sample 
number check box.

7. If the Sample number check box is selected, in the Number of digits field, type the 
number of digits to include in the sample name. 

For example, if 3 is typed, the sample names would be samplename001, 
samplename002, samplename003.

8. In the Data file section, in the Prefix field, type a name for the data file that will store 
the sample information. 

9. Select the Set name check box to use the set name as part of the data file name.

10. Select the Auto Increment check box to increment the data file names 
automatically.

11. In the Sub Folder field, type a name.

The folder is stored in the Data folder for the current project. If the Sub folder field is 
left blank, the data file is stored in the Data folder and a subfolder is not created.

12. In the New samples section, in the Number field, type the number of new samples.

13. Click OK.

The sample table fills with the sample names and data file names.

Note: The data for each sample can be stored in the same or separate 
data file. The names of the data file will have numerical suffixes starting 
from 1.
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14. In the Sample tab, in the Acquisition section, select a method from the list.

Depending on how the system is set up, specific information for the autosampler 
must be entered. Even if the injection volume is set in the method, the injection 
volume can be changed for one or more samples by changing the value in the 
injection volume column.

15. To change the injection volumes from the volumes listed in the method, in the Inj. 
Volume (µL) column, type the injection volume for each sample.

16. To set sample locations, do one of the following:

• Set Sample Locations in the Batch Editor on page 59

• Select Vial Positions using the Locations Tab on page 59

17. Click the Submit tab.

18. If the Submit Status section contains a message about the status of the batch, do 
one of the following:

• If the message indicates that the batch is ready for submission, proceed to 
step 19.

• If the message indicates that the batch is not ready for submission, make the 
changes as indicated by the message.

19. Click Submit.

Change Sample Order
The order of the samples can be edited before they are submitted to the Queue.

• In the Submit tab, double-click any of the numbers on the far left of the table (a very 
faint square box is visible), and then drag them to the new location

Acquire Data
The system should not be in Tune mode when sample acquisition is started. Also, if the system 
has been previously run that day and has not yet been set to Standby, sample acquisition will 
start automatically.

1. In the Navigation Bar, click Acquire.

2. Click View > Sample Queue.

Tip!  Fill Down and Auto Increment options are available in the right-click 
menu after a single column heading or several rows in a column are 
selected. 

Tip! To use different methods for some of the samples in this set, select 
the Use Multiple Methods check box. The Acquisition Method column is 
shown in the Sample table. Select the acquisition method for each sample 
in this column.
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The Queue Manager opens with all submitted samples.

3. Click Acquire > Start Sample.

Set Sample Locations in the Batch Editor
If an autosampler is used in the acquisition method, then the vial positions of the samples must 
be defined in the acquisition batch. Define the location in the Sample tab or in the Locations tab. 
For more information about creating batches, refer to Create and Submit a Batch on page 56.

1. In the Sample tab, in the Set list, select the set.

2. For each sample in the set, do the following if applicable:

• In the Rack Code column, select the rack type.

• In the Rack Position column, select the position of the rack in the 
autosampler.

• In the Plate Code column, select the plate type.

• In the Plate Position column, select the position of the plate on the rack.

• In the Vial Position column, type the position of the vial in the plate or tray.

3. Save the file.

Select Vial Positions using the Locations Tab
1. In the Batch Editor, click the Locations tab.

Figure 6-4 Queue Manager

Item Description
1 The Tune icon should not be pressed in.

2 Queue status.

3 Queue Server should be in Normal mode. For more information, 
refer to Queue States on page 63.

Note: Depending on the autosampler being using, it may not be necessary to 
type details in additional columns.

3

1

2
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2. In the Set list, select the set.

3. In the Autosampler list, select the autosampler.

The appropriate number of rack spaces for the autosampler is shown in the graphic 
rack display.

4. In the space associated with the rack, right-click and then select the rack type.

The plates or trays are shown in the rack.

5. Double-click one of the rectangles.

The circles depicting the wells or vials for the plate or tray appear.

6. To select whether samples are marked by row or column, click Row/Column 
Selection.

If the button shows a red horizontal line, the Batch Editor marks the samples by row. 
If the button shows a red vertical line, the Batch Editor marks the samples by 
column.

7. Click the sample wells or vials in the order to be analyzed. Click a selected well or 
vial again to clear it.

8. Save the file.

Tip! To auto fill in the samples, hold down the Shift key and then click the 
first and last vial within a set. To perform multiple injections from the same 
vial, hold down the Ctrl key and then click the vial location. The red circle 
changes to a green circle.
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Stop Sample Acquisition
When a sample acquisition is stopped, the current scan finishes before the acquisition is 
stopped.

1. In the Queue Manager, click the sample in the queue after the point where 
acquisition should stop.

2. In the Navigation Bar, click Acquire.

3. Click Acquire > Stop Sample.

The queue stops after the current scan in the selected sample is complete. The 
sample status in the Queue Manager (Local) window changes to Terminated, and all 
other samples following in the queue are waiting.

4. To continue processing the batch, click Acquire > Start Sample.

Batch and Acquisition Method Editor Tips
Table 6-1 Tips 

To do this... ...do this
To change all the values in a column 
simultaneously

click a column heading and then right-click. From the 
menu, use the Auto Increment and Fill Down commands 
to change the values in the column.

This also works for multiple cells in the same column.

To change an existing acquisition 
method

from the list, select the method and then click Method 
Editor. To create a new acquisition method, from the list, 
select None and then click Method Editor. Only 
experienced users should use this feature.

Do not use this feature if the Use Multiple Methods option 
is used. 

To apply a previously created 
quantitation method

select the method from the Quantitation menu.

To select more than one well or vial 
at a time

hold down the Shift key and then click the first and last 
well or vial in the range. 
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Batch Editor Right-Click Menu
Right-click in the Batch Editor table to access the following options.

Queue States and Device Status
The Queue Manager shows queue, batch, and sample status. Detailed information about a 
particular sample in the queue can also be viewed.

Figure 6-5 Batch Right-Click menu 

Menu Function
Open Opens a batch file.

Import From Imports a file.

Save As Batch Saves the batch.

Save As a Template Saves the batch as a template. Used with the Express View 
feature.

Hide/Show Column Hides or shows a column.

Save Column Settings Saves the batch column settings.

Add Custom Column Adds a custom column.

Delete Custom Column Deletes a custom column.

Fill Down Fills the same data into the selected cells.

Auto Increment Automatically increments data into the selected cells.

Delete Samples Deletes the selected row.

Select Autosampler Selects an autosampler.
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Queue States
The current state of the queue is indicated in the Queue Server.

Figure 6-6 Queue Server indicator showing Normal mode

Figure 6-7 Queue Server indicator showing Tune mode

The first icon in Figure 6-6 shows the queue state. The second icon indicates whether the queue 
is in Tune mode (for tuning) or Normal mode (for running samples). Table 6-2 shows the various 
queue states.

Table 6-2 Queue States

Icons State Definition
Not Ready In the Not Ready state, the hardware profile is 

deactivated and the queue is not accepting any 
sample submissions.

Stand By In the Stand By state, the hardware profile has been 
activated, but all devices are idle. Pumps are not 
running and gases are turned off.

Warming Up In the Warming Up state, the instrument and 
devices are equilibrating, columns are being 
conditioned, the autosampler needle is being 
washed, and column ovens are reaching 
temperature. The period of equilibration is selected 
by the operator. From this state, the system can go 
to the Ready state.

Ready In the Ready state, the system is ready to start 
running samples and the devices have been 
equilibrated and are ready to run. In this state, the 
queue can receive samples and will run after 
samples are submitted.

Waiting In the Waiting state, the system will automatically 
begin acquisition when the next sample is 
submitted.
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View Instrument and Device Status Icons
Icons representing the instrument and each device in the active hardware configuration appear 
on the status bar in the bottom right corner of the window. The user can view the detailed status 
of an LC pump to check if the LC pump pressure is appropriate, or view the detailed status of the 
instrument to check the temperature of the ion source.

• On the status bar, double-click the icon for the device or instrument.

The Instrument Status dialog opens.

Prerun In the Prerun state, the method is being 
downloaded to each device and device equilibration 
is occurring. This state occurs before the acquisition 
of each sample in a batch.

Acquiring In the Acquiring state, the method is run and data 
acquisition occurs.

Paused In the Paused state, the instrument has been 
paused during acquisition.

Table 6-3 Instrument and Device Status (showing the instrument icon)  

Status Icon Background Color Description
Idle Green or yellow The device is not running. If the background 

color is yellow, the device should be equilibrated 
before it is ready to run. If the background color 
is green, the device is ready to run.

Equilibrating Green or yellow The device is equilibrating.

Waiting Green The device is waiting for a command from the 
software, from another device, or for some 
action by the operator.

Running Green The device is running.

Table 6-2 Queue States (Continued)

Icons State Definition
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Queue Right-Click Menu
Right-click in the Queue table to access the following options.

Aborting Green The device is aborting a run.

Downloading Green A method is being transferred to the device.

Ready Green The device is not running, but is ready to run.

Error Red The device has encountered an error that 
should be investigated.

Note: For each status the background color can also be red. This situation means that 
the device encountered an error while in that status.

Figure 6-8 Queue Manager Right-Click Menu 

Menu Function
Sample Details Opens the Sample Details dialog.

Reacquire Acquires a sample again.

Insert Pause Inserts a pause, in seconds, between two samples.

Delete Deletes either the batch or the selected samples.

Table 6-3 Instrument and Device Status (showing the instrument icon) (Continued)  

Status Icon Background Color Description
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Icon Quick Reference: Acquire Mode

Move Batch Moves the batch within the queue.

Sort Sorts by the preselect column.

Column Settings Changes the column settings.

Table 6-4 Acquire Mode Icons 

Icon Name Function
View Queue View the sample queue.

Instrument Queue View a remote instrument station.

Status for Remote Instrument View the status of a remote instrument.

Start Sample Starts the sample in the queue.

Stop Sample Stops the sample in the queue.

Abort Sample Aborts a sample acquisition in the middle of the 
processing of that sample.

Stop Queue Stops the queue before it has completed processing 
all the samples.

Pause Sample Now Inserts a pause in the queue.

Insert Pause before Selected 
Sample

Inserts a pause before a specific sample.

Continue Sample Continues acquiring the sample.

Next Period Starts a new period.

Extend Period Extends the current period.

Next Sample Stops acquiring the current sample and to start 
acquiring the next sample.

Figure 6-8 Queue Manager Right-Click Menu  (Continued)

Menu Function
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Equilibrate Click to select a method to use to equilibrate the 
devices. This method should be the same as the 
method used with the first sample in the queue.

Standby Puts the instrument in Standby mode.

Ready Puts the instrument in Ready mode.

Reserve Instrument for 
Tuning

Reserves the instrument for tuning and calibrating.

IDA Method Wizard Starts the IDA Method Wizard.

Table 6-4 Acquire Mode Icons  (Continued)

Icon Name Function
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7
Analyzing and Processing Data
Use the sample files installed in the Example folder to learn how to view and analyze data using 
the most common analysis and processing tools. For more information about the following topics, 
refer to the Advanced User Guide.

• Labelling graphs

• Overlaying and summing spectra or chromatograms

• Performing background subtractions

• Smoothing algorithms

• Working with smoothed data

• Working with centroid data

• Working with contour plots

• Working with the fragment interpretation tool

• Working with library databases and library records

Open Data Files
Prerequisite: The Example project is selected.

1. In the Navigation Bar, under Explore, double-click Open Data File. 

The Select Sample dialog opens.

2. In the Data Files list, double-click Triple Quad.

3. Select QuanData.wiff.

4. In the Samples list, select sample AP13-020.

5. Click OK.

The data acquired from the sample is shown. If data is still being acquired, the mass 
spectrum, DAD/UV trace, and TIC continue to update automatically.

Navigate Between Samples in a Data File
Prerequisite: The Example project is selected.

Table 7-9 shows the navigation icons used in this procedure. If samples were saved in separate 
data files, then open each file individually.

1. In the Navigation Bar, under Explore, double-click Open Data File. 

2. In the Data Files list, double-click Triple Quad.

3. Select QuanData.wiff. 

Tip! To turn off the automatic update on the mass spectrum, right-click 
the mass spectrum and then click Show Last Scan. If there is a check 
mark beside Show Last Scan, then the spectrum will update in real time. 
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Analyzing and Processing Data
4. To skip to the next sample in the data file, click the icon with the arrow pointing to the 
right.

5. To skip to a non-sequential sample, click the icon with the arrow curving to the right.

6. In the Select Sample dialog, in the Sample list, select the sample.

7. To go to the previous sample in the data file, click the icon with the arrow pointing to 
the left.

Show Experimental Conditions
The experimental conditions used to collect data are stored in the data file with the results. The 
information contains the details of the acquisition method used: the MS acquisition method (that 
is, the number of periods, experiments and cycles) including instrument parameters, and HPLC 
device method (LC pump flow rate). In addition, it also contains the MS resolution and mass 
calibration tables used for the sample acquisition. Table 7-1 shows the software functionality 
available when the user views the file information.

• Click Explore > Show > Show File Information. 

The File Information pane opens below the graph.

Show Data in Tables 
• With a data file open, click Explore > Show > Show List Data.

The data is shown in a pane below the graph.

Note: If data is acquired from more than one sample into the same .wiff file, the file 
information pane will not refresh automatically as the user scrolls through the samples. 
Close the file information pane and then reopen it to view the details for the next sample 
in the .wiff file. 

Tip! To create an acquisition method from the file information pane, right-
click the file information pane and then click Save Acquisition Method.

Table 7-1 Right-Click Menu for Show File Information Pane

Menu Function
Copy Copies the selected data.

Paste Pastes data.

Select All Selects all the data in the pane.

Save To File Saves data in an .rtf file.

Font Changes the font.

Save Acquisition Method Saves the acquisition method as .dam file.

Save Acquisition Method to 
CompoundDB

Opens the Specify Compound Information dialog. Select 
the IDs and molecular weights to be saved in the 
compound database.

Delete Pane Deletes the pane.
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Table 7-2 RIght-Click Menu for the Spectral Peak List Tab

Menu Function
Column Options Opens the Select Columns for Peak List dialog.

Save As Text Saves the data as text file.

Delete Pane Deletes the pane.

Table 7-3 Right-Click Menu for the Chromatographic Peak List Tab

Menu Function
Analyst Classic 
Parameters

Opens the Analyst Classic dialog.

IntelliQuan Parameters Opens the Intelliquan dialog.

Save As Text Saves the data as text file.

Delete Pane Deletes the pane.
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Show ADC Data
ADC (analog-to-digital converter) data is acquired from a secondary detector (for example from a 
UV detector through an ADC card), and is useful for comparison with mass spectrometer data. To 
have ADC data available, acquire the data and the mass spectrometer data simultaneously and 
save it in the same file.

Prerequisite: The Example project is selected.

1. In the Navigation Bar, under Explore, double-click Open Data File. 

The Select Sample dialog opens.

2. In the Data Files list, double-click Devices, and then click Adc16chan.wiff.

3. In the Samples list, select a sample.

4. Click OK.

5. Click Explore > Show > Show ADC Data.

The Select ADC Channel dialog opens.

6. In the Channel list, select a channel.

7. Click OK.

The ADC data opens in a new pane below the active pane.

Show Basic Quantitative Data
1. In the Peak List tab, right-click and select Show Peaks in Graph.

Peaks appear in two colors.

2. To change the peak finding algorithm settings right-click and then select either 
Analyst Classic Parameters or Intelliquan Parameters, which ever is active.

3. To remove the colored peaks, right-click in the Peak List tab and then clear Show 
Peaks in Graph. 
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Chromatograms

Show TICs from a Spectrum
Prerequisite: The Example project is selected.

1. In the Navigation Bar, under Explore, double-click Open Data File. 

The Select Sample dialog opens.

2. In the Data Files list, double-click LIT, and then click Reserpine.wiff.

3. Click OK.

4. Click Explore > Show > Show TIC.

The TIC opens in a new pane.

Table 7-4 Chromatograms

Types of chromatograms Purpose
TIC (Total Ion Chromatogram) A chromatographic display generated by plotting the intensity 

of all ions in a scan against time or scan number.

When a data file is opened, it is preset to appear as a TIC. If 
the experiment contains only one scan, it is shown as a 
spectrum. For more information about using the available 
icons, refer to Table 7-8 Graph Options on page 81.

If the MCA check box is selected during acquisition of the data 
file, then the data file opens to the mass spectrum. If the MCA 
check box is not selected, then the data file opens with the TIC

XIC (Extracted Ion 
Chromatogram)

An ion chromatogram created by taking intensity values at a 
single, discrete mass value, or a mass range, from a series of 
mass spectral scans. It indicates the behavior of a given mass, 
or mass range, as a function of time.

BPC (Base Peak 
Chromatogram)

Chromatographic plot that shows the intensity of the most 
intense ion within a scan versus time or scan number. 

TWC (Total Wavelength 
Chromatogram) 

A chromatographic display created by summing all of the 
absorbance values in the acquired wavelength range and then 
plotting the values against time. It consists of the summed 
absorbances of all ions in a scan plotted against time in a 
chromatographic pane.

XWC (Extracted Wavelength 
Chromatogram) 

A subset of TWC. An XWC shows the absorbance for a single 
wavelength or the sum of the absorbance for a range of 
wavelengths. 

DAD (Diode Array Detector) A UV detector that monitors the absorption spectrum of eluting 
compounds at one or more wavelengths. 

Tip! Right-click inside a pane containing a spectrum and then click Show 
TIC.
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Show a Spectrum from a TIC
1. In a pane containing a TIC, select a range.

2. Click Explore > Show > Show Spectrum.

The spectrum opens in a new pane.

Generate XICs
The user can generate XICs only from single period, single experiment chromatograms or 
spectra. To obtain an XIC from multi-period or multi-experiment data, split the data into separate 
panes by clicking the triangle that is under the x-axis. For more information about using the 
available icons, refer to Table 7-8 Graph Options on page 81.

There are several methods for extracting ions to generate an XIC, depending on whether 
chromatographic or spectral data is used. Table 7-5 contains a summary of methods that can be 
used with chromatograms and spectra.

Tip! Double-click in the TIC pane at a particular time to show the 
spectrum.

Table 7-5 Summary of XIC Generation Methods 

Method Use with 
chromatogram

Use with 
spectrum

Extraction 

Selected range No Yes The selected range method extracts 
ions from a selected area in a 
spectrum.

Maximum No Yes The maximum method extracts ions 
from a selected area in a spectrum 
using the most intense peak in the 
selected area. This creates an XIC 
using the maximum mass from the 
selected spectral range.

Base peak 
masses

Yes No The base peak masses method can be 
used only with BPCs (Base Peak 
Chromatograms.) Use the Use Base 
Peak Masses command to extract ions 
results in an XIC with a different 
colored trace for each mass. If the 
selection includes multiple peaks, the 
resulting XIC will have an equal 
number of colored traces representing 
each mass.

Specified masses Yes Yes The specified masses method extracts 
ions from any type of spectrum or 
chromatogram. Select up to ten start 
and stop masses for which to generate 
XICs.
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To generate an XIC using a selected range

1. In the Navigation Bar, under Explore, double-click Open Data File. 

The Select Sample dialog opens.

2. In the Data Files list, double-click LIT, and then click Reserpine.wiff.

3. Click OK.

4. To select a range inside the pane, click and hold the left mouse button at the start of 
the range and then drag the cursor to the stop point and release.

The selection is highlighted in blue.

5. Click Explore > Extract Ions > Use Range.

An XIC of the specified selection opens in a pane below the spectrum pane. The 
experiment information at the top of the pane contains the mass range and the 
maximum intensity in counts per second. 

To generate an XIC using the maximum peak

1. In the Navigation Bar, under Explore, double-click Open Data File. 

The Select Sample dialog opens.

2. In the Data Files list, double-click LIT, and then click Reserpine.wiff.

3. Click OK.

4. Select a range. 

The selection is highlighted in blue.

5. Click Explore > Extract Ions > Use Maximum.

An XIC of the maximum peak specified selection opens below the spectrum pane. 
The experiment information at the top of the pane contains the mass range and the 
maximum intensity in counts per second. 

To generate an XIC using base peak masses

1. In a BPC, select the peak from which to extract ions. 

The selection is highlighted in blue.

2. Click Explore > Extract Ions > Use Base Peak Masses.

An XIC of the specified selection opens below the spectrum pane. The experiment 
information at the top of the pane shows the mass range and the maximum intensity 
in counts per second. 

To extract ions by selecting masses 

1. Open a spectrum or chromatogram.

2. Click Explore > Extract Ions > Use Dialog.
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Figure 7-1 Extract Ions dialog

3. Type the values for each XIC to be created. If a stop value is not typed, then the 
range is defined by the start value. 

• In the Start field, type the start value (lower value) for the mass range. 

• In the Stop field, type the stop value (higher value) for the mass range.

4. Click OK.

An XIC of the selection opens below the chromatogram pane. The experiment 
information at the top of the pane includes the masses and the maximum intensity in 
counts per second. 

Generate BPCs
BPCs can be generated only from single period, single experiment data. For more information 
about using the available icons, refer to Table 7-8 Graph Options on page 81.

1. Select an area within a TIC. 

The selection is highlighted in blue. 

2. Click Explore > Show > Show Base Peak Chromatogram.

The selections are shown in the Start Time and End Time fields.
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Analyzing and Processing Data
Figure 7-2 Base Peak Chromatogram Options dialog

3. In the Mass Tolerance field, type the value to dictate the mass range used to find a 
peak. The software finds the peak using a value twice the typed range (± the mass 
value). 

4. In the Minimum Intensity field, type the intensity below which peaks are ignored by 
the algorithm.

5. In the Minimum Mass field, type the mass that determines the beginning of the scan 
range.

6. In the Maximum Mass field, type the mass that determines the end of the scan 
range.

7. To set the start and end times, select the Use Limited Range check box and do the 
following:

• In the Start Time field, type the time that determines the start of the 
experiment.

• In the End Time field, type the time that determines the end of the experiment.

8. Click OK. 

The BPC is generated in a new pane.

Generate XWCs
The user can extract up to three ranges from a DAD spectrum to generate the XWC. For more 
information about using the available icons, refer to Table 7-8 Graph Options on page 81.

1. Open a data file that contains a DAD spectrum. 

2. Anywhere in the pane, right-click and then click Extract Wavelengths. 
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Figure 7-3 Extract Wavelengths dialog

3. Type start and stop values.

4. Click OK. 

The XWC opens in a pane below the DAD spectrum.

Show DAD Data
The user can view DAD data in chromatogram or spectrum form, the same as mass 
spectrometer data. 

1. Open a data file containing data acquired with a DAD. 

2. The TWC, which is analogous to a TIC, opens in a pane below the TIC. 

3. In the TWC pane, click a point to select a single point in time, or highlight an area of 
the spectrum to select a range of time.

4. Click Explore > Show > Show DAD Spectrum. 

The DAD spectrum opens in a pane below the TWC. The y-axis shows absorbance 
and the x-axis shows wavelength.

Generate TWCs
A TWC shows total absorbance (mAU) on the y-axis plotted against time on the x-axis. For more 
information about using the available icons, refer to Table 7-8 Graph Options on page 81.

1. Open a data file that contains a DAD spectrum. 

2. Click Explore > Show > Show DAD TWC. 

The TWC opens in a pane below the DAD spectrum.

Tip! If the pane with the TWC is closed, click a point anywhere in the TWC 
to open it again. Click Explore > Show > Show DAD TWC.

Tip! Right-click inside the pane containing the DAD spectrum and then 
click Show DAD TWC.
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Adjust the Threshold 
The threshold is an invisible line drawn parallel to the x-axis of a graph that sets a limit below 
which the software will not include peaks in a spectrum. The line has a handle, represented by a 
blue triangle to the left of the y-axis. Click the blue triangle to view a dotted line that represents 
the threshold. The threshold can be raised or lowered, but changing the threshold value does not 
change the data. The software does not label any peaks in the region that lies below the 
threshold. 

1. Open a data file.

2. Adjust the threshold using one of the following steps:

• To raise the threshold, drag the blue triangle up the y-axis. To lower the 
threshold, drag the blue triangle down.

• Click Explore > Set Threshold. In the Threshold Options dialog that opens, 
type the threshold value.

• Click Explore > Threshold.

The graph updates to show the new threshold. Peak labeling and the peak list are 
also updated.

Tip! To view the current threshold value, move the pointer over the 
threshold handle.

Table 7-6 Right-Click Menu for Chromatogram Panes 

Menu Function
List Data Lists the data points and integrates chromatograms.

Show Spectrum Generates a new pane.

Show Contour Plot Shows a color-coded plot of a data set, where the color represents 
the intensity of the data at that point. Only certain MS modes are 
supported.

Extract Ions Extracts a specific ion or set of ions from a selected pane and then 
generates a new pane containing a chromatograph for the specific 
ions.

Show Base Peak 
Chromatogram

Generates a new pane containing a base peak chromatogram.

Show ADC Data Generates a new pane containing the UV data trace, if acquired.

Spectral Arithmetic 
Wizard

Opens the Spectral Arithmetic Wizard.

Save to Text File Generates a text file of the pane, which can be opened in Excel or 
other programs.

Save Explore History The Explore History File records changes to processing parameters, 
also called Processing Options, when a .wiff file is processed in 
Explore mode. The processing history is stored in a file with an .EPH 
(Explore Processing History) extension.

Add Caption Adds a caption at the cursor point in the pane.

Add User Text Adds a text box at the position of the mouse cursor.
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Data Processing
Graphical data can be processed many ways. This section provides information and procedures 
for using some of the most commonly used tools.

The user can zoom in on part of a graph to view a particular peak or an area in greater detail in 
both spectra and chromatograms. The user can also zoom in repeatedly to view smaller peaks.

Set Subtract Range Sets the subtract range in the pane.

Clear Subtract Range Clears the subtract range in the pane.

Subtract Range Locked Locks or unlocks the subtract ranges. If the subtract ranges are not 
locked then each subtract range can be moved independently. The 
subtract ranges are preset to locked.

Delete Pane Deletes the selected pane.

Table 7-7 Right-Click Menu for Spectra Panes 

Menu Function
List Data Lists the data points and integrates chromatograms.

Show TIC Generates a new pane containing the TIC.

Extract Ions Extracts a specific ion or set of ions from a selected pane and then 
generates a new pane containing a chromatograph for the specific 
ions.

Save to Text File Generates a text file of the pane, which can be opened in Excel or 
other programs.

Save Explore History The Explore History File records changes to processing parameters, 
also called Processing Options, when a .wiff file is processed in 
Explore mode. The processing history is stored in a file with an .EPH 
(Explore Processing History) extension.

Add Caption Adds a caption at the cursor point in the pane.

Add User Text Adds a text box at the position of the mouse cursor.

Show Last Scan Shows the scan prior to the selection. 

Select Peaks For Label In this dialog, select the parameters to reduce peak labeling.

Delete Pane Deletes the selected pane. 

Add a Record Add records and compound-related data including spectra to the 
library. An active spectrum is required to perform this task.

Search Library Searches the library without constraints or with previously saved 
constraints.

Search With Constraints Searches using the Search Constraints dialog.

Table 7-6 Right-Click Menu for Chromatogram Panes  (Continued)

Menu Function
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Graphs
The same data can be examined in different ways. Data can also be kept for comparison 
purposes before performing processing operations such as smoothing or subtraction.

A window contains one or more panes arranged in such a way that all the panes are fully visible 
and they do not overlap.

Panes may be of variable or fixed size. Panes are automatically tiled within the window and are 
arranged into column and row format. If the size of a window is changed, the panes within the 
window change in size to accommodate the new size. A window cannot be sized to the point 
where any of the panes would become smaller than its minimum size.

Two or more windows or panes containing similar data can be linked, for example, spectra with 
similar mass ranges. As one pane or window is zoomed in, the other pane zooms in 
simultaneously.

For example, the user can link an XIC to the BPC from which the XIC was extracted. Zooming in 
the BPC also zooms the XIC, so that both chromatograms show the same magnification.

Table 7-8  Graph Options

To do this... use this menu option... ...or click this 
icon

Copy a graph to a 
new window

• Select the graph to copy. Click Explore > 
Duplicate Data > In New Window.

Rescale graph to its 
original size

• Select the graph. Click Explore > Home Graph.

Move a pane • Select the graph. Click Window > Move Pane.

• Select the pane or window and then drag it to 
the new position. This position can be within the 
same window or within another window.

A four-headed arrow is shown when the cursor is 
on the boundary of the active window or pane.

• If the pane is at the top or bottom of the 
target pane, the pane moves above or 
below that pane, respectively.

• If the pane is at the left or right of the target 
pane, the pane moves to the left or right of 
that pane, respectively.

• If the pane is at any other position, the pane 
moves to the target row. The drop shadow 
of the pane as the pane is moved around 
indicates its new position.

Link panes 1. With the two graphs open, click one to make 
that pane active.

2. Click Explore > Link and then click the other 
pane.
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Zoom in on the y-axis
1. Position the pointer to the left of the y-axis and then drag vertically away from the 

starting point. 

A box is drawn along the y-axis representing the new scale.

2. Release the mouse button to draw the graph to the new scale.

Zoom in on the x-axis
1. Position the pointer under the x-axis to either side of the area to expands and then 

drag away from the starting point in a horizontal direction to expand the area of 
interest.

2. Release the mouse button to redraw the graph to the new scale.

Remove linking • Close one of the panes. Click Explore > 
Remove Link

Delete a pane • Select the graph. Click Window > Delete Pane.

Lock a pane • Select the graph. Click Window > Lock Panes.

Hide a pane • Select the graph. Click Window > Hide Pane.

Maximize a pane • Select the graph. Click Window > Maximize 
Pane.

Tile panes • Select the graph. Click Window > Tile all 
Panes.

Note:  Take care when zooming in on the baseline. Zoom in too low and 
the zoom-in box disappears.

Tip! To return the graph to the original scale, double-click on either axis. 
To restore the entire graph to original scale, click Explore > Home Graph.

Table 7-8  Graph Options (Continued)

To do this... use this menu option... ...or click this 
icon
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Table 7-9 Explore Quick Reference: Chromatograms and Spectrum 

Icon Name Function
Open File Opens files.

Show Next Sample Goes to the next sample.

Show Previous Sample Goes to the previous sample.

GoTo Sample Opens the Select Sample dialog.

List Data Views the data in tables.

Show TIC Generates a TIC from a spectrum.

Extract Using Dialog Extracts ions by selecting masses.

Show Base Peak 
Chromatogram

Generates a BPC.

Show Spectrum Generates a spectrum from a TIC.

Copy Graph to new Window Copies the active graph to a new window.

Baseline Subtract Opens the Baseline Subtract dialog.

Threshold Adjusts the threshold.

Noise Filter Click to use the Noise Filter Options dialog to define 
the minimum width of a peak. Signals below this 
minimum width are regarded as noise.

Show ADC View ADC data.

Show File Info Shows the experimental conditions used to collect 
the data.

Add arrows Add arrows to the x-axis of the active graph.
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Remove all arrows Remove arrows from the x-axis of the active graph.

Offset Graph Click to compensate for slight differences in the time 
during which the ADC data and the mass 
spectrometer data were recorded. This is useful 
when overlaying graphs for comparison.

Force Peak Labels Labels all the peaks.

Expand Selection By Sets the expansion factor for a portion of a graph to 
be viewed in greater detail.

Clear ranges Return the expanded selection to normal view.

Set Selection Click to type start and stop points for a selection. 
This provides more accurate selection than is 
possible by highlighting the region using the cursor.

Normalize to Max Click to scale a graph to maximum, so that the most 
intense peak is scaled is to full scale, whether or not 
it is visible.

Show History View a summary of data processing operations 
performed on a particular file, such as smoothing, 
subtraction, calibration, and noise filtering.

Open Compound Database Opens the compound database.

Set Threshold Adjusts the threshold.

Show Contour Plot Shows selected data as either a spectrum graph or 
an XIC. Additionally, for data acquired by a DAD, a 
contour plot can show selected data as either a DAD 
spectrum or an XWC.

Show DAD TWC Generates a TWC of the DAD.

Show DAD Generates a DAD.

Extract Wavelength Extracts up to three wavelength ranges from a DAD 
spectrum to view the XWC.

Table 7-9 Explore Quick Reference: Chromatograms and Spectrum  (Continued)

Icon Name Function
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Use the sample files found in the Example folder to learn how to select samples for quantitation, 
how to select preset queries and create table-specific queries, and how to analyze the acquired 
data. For more information about the following topics, refer to the Advanced User Guide.

• Metric Plots

• Layout of a Results Table

Quantitative Analysis
Quantitative analysis is used to find the concentration of a particular substance in a sample. By 
analyzing an unknown sample and comparing it to other samples containing the same substance 
with known concentrations (standards), the software can calculate the concentration of the 
unknown sample. The process involves creating a calibration curve using the standards and then 
calculating the concentration for the unknown sample. The calculated concentrations of each 
sample are then available in a Results Table. 

Quantitation Methods
A quantitation method is a set of parameters used to generate peaks in a sample. The 
quantitation method can include parameters used to locate and integrate peaks, generate 
standard curves, and calculate unknown concentrations. A previously saved quantitation method 
can be selected from the Quantitation menu in the batch. For information about creating a batch, 
refer to Create and Submit a Batch on page 56.

The user can create a quantitation method before data acquisition and then apply the method to 
the quantitative data automatically after the batch is complete. Alternatively, a quantitation 
method can be created and applied post-acquisition.

Three tools can be used to create a quantitation method: the Quantitation Wizard, the Build 
Quantitation Method, and Quick Quant.

Build Quantitation Method

The Build Quantitation Method does not generate a Quantitation Results Table although the 
method can subsequently be used in the Quantitation Wizard to create a Results Table. The 
Build Quantitation Method can also be used to change existing quantitation methods. This is the 
most flexible way of creating a quantitation method.

Quantitation Wizard

With the Quantitation Wizard, a Results Table is generated at the same time as the quantitation 
method. Alternatively, an existing quantitation method can be used to quantitate different sets of 
data. This is the most common way of creating a quantitation method.
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Quick Quant

Quick Quant is part of the Batch Editor. Use Quick Quant to add compound concentrations prior 
to data acquisition. Because a sample has not been acquired, a representative sample cannot be 
be selected or any peaks reviewed. With this process, only the method components are defined. 

About Results Tables
Results Tables summarize the calculated concentration of an analyte in each unknown sample 
based on the calibration curve. Results Tables also include the calibration curves as well as 
statistics for the results. The user can customize the Results Table and view the Results Tables in 
layouts.

The data from a Results Table can be exported to a .txt file for use in other applications, such as 
Microsoft Excel. The user can also export data in the table or just the data in the visible columns.

Quantitation Methods and Results Tables
For the following procedures, use the sample data that is installed with the software. PK Data 
contains the batches Mix_Batch1 and Mix_Batch2. These sample batches are used to 
demonstrate the usefulness of metric plots to isolate problematic samples. The ions scanned 
were reserpine (609.4/195.0), minoxidil (210.2/164.2), tolbutamide (271.3/91.1) and 
rescinnamine (635.4/221.2), which is the internal standard. Batch 1 contains no errors in terms of 
sample preparation, whereas Batch 2 contains a QC sample where the internal standard was 
added twice (sample QC2). 

Create a Method using the Quantitation Method Editor
Prerequisites: 

• The Example project is selected.

• The Analyst Classic algorithm is used.

1. In the Navigation Bar, under Quantitate, double-click Build Quantitation Method. 

The Select Sample dialog opens. 

2. In the Data Files list, double-click the Triple Quad folder.

3. Select Mix_Batch_2. wiff.

The samples in the selected data file appear in the Samples list.

4. Click OK.

5. In the Internal Standards table, do the following:

i. In the Name column, select rescinnamine. 
ii. In the Q1/Q3 column, select 635.400/221.185 for each standard.

6. In the Analytes table, do the following:

Note: If the Compound ID field was populated for the samples and internal 
standards in the acquisition method, then in the Internal Standards table, 
when a value in the Q1/Q3 field is selected, the Name field is automatically 
populated.
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i. In the Name column, select reserpine. 
ii. In the Internal Standard column, from the list, select the internal standard to 

be associated with each analyte.
iii. In the Q1/Q3 column, select 609.400/195.039.
iv. If required, add one or more of the other compounds for a more complex 

analysis.

7. Click the Integration tab.

8. In general, the preset integration parameters are suitable for most peaks. If the 
integration is not suitable, then change the algorithm. 

9. Click the Show or Hide Parameters icon to show the additional integration 
algorithms.

10. Click the Calibration tab. The preset parameters are suitable for these samples.

11. Save the quantitation method.

The new method can be used when a batch is created in the Batch Editor or when 
the Quantitation Wizard is used to generate a Results Table.

Create a Results Table using the Quantitation Wizard
Prerequisites 

• The Example project is selected.

• The Analyst Classic algorithm is used.

1. In the Navigation Bar, under Quantitate, double-click Quantitation Wizard.

The Create Quantitation Set - Select Samples page opens.

2. In the Available Data Files list, double-click the Triple Quad folder.

3. Select Mix_Batch_2.wiff.

4. Click Add All Files.

5. Click Next.

The Create Quantitation Set - Select Settings & Query page opens.

6. In the Default Query section, click Select Existing: Query.

7. In the Query list, select Accuracy 15%. 

8. Click Next.

Note: If the Compound ID field was populated for the samples and internal 
standards in the acquisition method, then in the Analytes table, the Name 
field and Q1/Q3 field are populated.

Note: The quantitation method can only be used in the current project 
unless it is copied to another project. To do this, click Tools > Project > 
Copy Data. A new project must be created and selected to be available for 
use.
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The Create Quantitation Set - Select Method page opens.

9. Click Choose Existing Method.

10. In the Method list, select PK Data_Mix.qmf.

11. Click Finish.

The Results Table opens.

12. Save the Results Table.

Create a Standard Query
A query and a standard query can be created numerous ways. The following is one example. For 
more information about creating queries, refer to the Help.

1. In the Navigation Bar, under Quantitate, double-click Quantitation Wizard.

2. In the Create Quantitation Set - Select Samples page, select samples.

3. Click Next.

4. In the Select Settings & Query page, in the Default Query section, select Create 
New Standard Query.

5. Type a query name.

Note: To create a query at the same time, refer to Create a Standard 
Query on page 88.

Tip! To add or remove samples in the Results Table, click Tools > 
Results Table > Add/Remove Samples.
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Figure 8-1 Create Quantitation Set - Select Settings & Query page

6. Click Next.

Figure 8-2 Create Default Query page

7. In the Maximum Allowed Accuracy Variation for QCs (%) table in the Max. 
Variation column, type the maximum allowable percent of variation for each QC (for 
example, 5 is ±5%) in the same row as the corresponding concentration. If the 
concentrations were not specified during acquisition, they do not appear here. In that 
case, type them in the Concentration column.

8. In the Maximum Allowed Accuracy Variation for Standards (%) table, in the Max. 
Variation column, type the maximum allowable percent of variation for each 
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standard (for example, 10 is ±10%) in the same row as the corresponding 
concentration. If the concentrations were not specified during acquisition, they do not 
appear here. In that case, type them in the Concentration column.

9. Click Next. 

Figure 8-3 Create Quantitation Set - Select Method page

10. Select or create a method.

11. Click Finish.

The query is applied as a standard query. The query results appear as a Pass or Fail 
entry in the Standard Query Status column of the Results Table.

Results Table Right-Click Menu
Right-click in the Results Table table to access the following options.

Tip!  To return to the full view, right-click and then click Full.
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Peak Review and Manual Integration of Peaks
Use peak review to survey the peaks that the software has identified, and then redefine the peak 
or the start and end points where necessary.

After identifying the analytes and internal standards that the software must find, the software 
searches for the peaks in the samples. When the software identifies a peak, it shows the 

Figure 8-4 Results Table Right-Click Menu 

Menu Function
Full Shows all the columns.

Summary Shows specific columns.

Analyte Shows a specific analyte.

Analyte Group Create an analyte group.

Sample Type Shows samples of a specific type or all samples.

Add Formula Column Adds a formula column.

Table Settings Edits or selects a table setting.

Query Creates or selects a query.

Sort Click to create a sort or to sort by index.

Metric Plot Creates a metric plot.

Delete Pane Deletes the active pane.

Fill Down Fills the same data into the selected cells.

Add Custom Column Adds a custom column.

Delete Custom Column Deletes the selected custom column.
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chromatograms for each analyte and internal standard in the Create Quantitation Method: Define 
Integration page of the Standard Wizard or on the Integration tab of the Full Method Editor. The 
user can confirm the peaks that are found or change the quantitation method to better define the 
peaks.

Review Peaks
During peak review, the user may want to view a peak in its entirety—or may want to examine the 
baseline to find out how well the software found the start and end points of the peak. Use the 
automatic zooming feature to do either.

To help the software find a peak, define the exact start and end points of the peak and 
background manually. These changes will apply only to that individual peak unless the global 
method is updated.

1. Right-click in the Results Table, click Analyte.

2. Select a sample.

3. Click Tools > Peak Review > Pane.

The peaks appear below the Results Table with only the peaks listed in the Results 
Table.

4. Right-click in the pane and then click Options.

5. In the Peak Review Options dialog, in the Appearance section, change Num. 
rows to 1 and Num. columns to 2.

6. In the Automatic Zooming section, click Zoom Y axis to: 100% of largest peak to 
show the entire peak.

Tip! To review an individual peak, right-click on a point on the curve and then click 
Show Peak. The software shows the Peak Review window with the selected peak. 
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7. Click OK.

8. To move through the peaks, click the right-pointing arrow. For more information, refer 
to Figure 8-6 Peak Review Pane on page 94.S

9. Go to the second injection of standard 3. 

In this example, the peak can be integrated closer to the baseline by selecting the 
Specify Parameters option.

Figure 8-5 Peak Review Options dialog

Item Definition
1 Num. rows

2 Num. columns

3 Zoom Y axis to 100% of largest peak

Tip! To move to a specific peak in the Peak Review pane, select the 
corresponding row in the Results Table.

2

1 3
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10. Click Show or Hide Parameters twice.

11. Click Specify Parameters -MQ III.

12. Change the Noise Percent value.

13. Click Apply.

The peak is integrated closer to the baseline.

14. If the change does not improve the peak integration, then adjust the Noise Percent 
parameter until the optimal value is found.

15. To update the algorithm for all peaks, right-click in the pane and then click Update 
Method.

Figure 8-6 Peak Review Pane

Item Description
1 Arrows: click to move through the peaks.

2 Show or Hide Parameters: click to show the integration parameters.

3 Integration parameters: click to change the parameters.

Note:  The Update Method function only updates the algorithm values for 
that specific analyte (or internal standard) and not all analytes.

1 2

3
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Figure 8-7 Update Method

Manually Integrate Peaks
Manually integrating peaks should be done last. Manually integrate peaks only if all the peaks 
have not been found after adjusting and updating the algorithm parameters. This is done to limit 
person-to-person variability.

1. In the Peak Review pane, click Manual Integration Mode.

Note: Peaks that are manually integrated, or where the algorithm was changed for 
only that peak, are identified as such in the Record Modified column of the Results 
Table, as are the peaks that have algorithm parameter changes for a sample but not 
updated to the entire analyte group.

1
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2. Zoom in on the lower 10% of the peak.

3. Position the cross-hair where the start of the peak is to be defined and then drag the 
cross-hair to where the end of the peak is to be defined.

The software shades the area bounded by the base and sides of the peak. Peak 
parameters are gray as they are no longer applicable because the peak was drawn 
manually.

4. Do one of the following: 

• To make this change permanent, click Accept.

• To discard the changes, clear the Manual Integration check box.

Peak Review Right-Click Menu
Right-click in the Peak Review window or pane to access the following options.

Figure 8-8 Peak Review pane: Manual integration

Item Description
1 Manual Integration Mode

Figure 8-9 Peak Review pane: Zooming in on a peak

Item Description
1 Lower 10% of the peak

Tip! If a peak was correct as originally selected, right-click the peak and 
then click Revert to Method.

1
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Calibration Curves
Use calibration curves to find the calculated concentration of samples, including QC (quality 
control) samples. QC samples are added to a batch to estimate the data quality and accuracy of 
standards in the batch. QC samples have known analyte concentrations but are treated as 
unknowns so that the measured concentrations can be compared to the actual value.

The calibration curve is generated by plotting the concentration of the standard versus its area or 
height. If an internal standard is used, the ratio of the standard concentration/internal standard 
versus the ratio of the standard peak height or area to the internal standard peak height or area is 
plotted. The area or height ratio of a sample is then applied to this curve to find the concentration 

Figure 8-10 Peak Review Right-Click Menu 

Menu Function
Options Opens the Peak Review Options dialog.

Sample Annotation Opens the Sample Annotation dialog.

Save Active to Text File Saves the selected peak as a text file.

Show First Page Goes to the first sample.

Show Last Page Goes to the last sample.

Slide Show Peak Review Opens the slide show.

Update Method Updates the algorithm for all peaks.

Revert to Method Click to have a redefined peak reselected based on the current 
quantitation method.

Delete Pane Deletes the active pane.
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of the sample, as shown in the Results Table. A regression equation is generated by this 
calibration curve according to the regression that was specified. The regression equation is used 
to calculate the concentration of the unknown samples.

View Calibration Curves
The user can view the calibration curve and change the regression options in an open Results 
Table. If there are two or more Results Tables open, the calibration curves can be overlaid. To 
overlay curves, the method used to create the tables must be the same.

Plot a calibration curve to see the curve used for regression. The Calculated Concentration field 
in the Results Table reflects any changes resulting from the fit of the curve to the points of the 
standard.

1. With a Results Table open, click Tools > Calibration > Pane. 

The Calibration Curve pane containing the calibration curve opens.

2. If there is more than one analyte, then use the following steps to view the calibration 
curve for another analyte:

i. In the Analyte list, select an analyte.
ii. If required, in the next list, select Area or Height.

3. To change the regression options for the calibration curve, do the following:

i. Click Regression.

Figure 8-11 Regression Options dialog

ii. In the Fit list, select Linear.
iii. In the Weight list, select 1 / x.
iv. Click OK.

The calibration curve opens. The user can review individual peaks on the curve or 
exclude points from the curve to produce a better curve. 

4. If required, repeat these steps to create a more appropriate curve.

5. To save the changes, click Accept.

Note: This option is available only when a Results Table is open in the workspace.
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Overlay Calibration Curves

1. With two or more open Results Tables, view a calibration curve for one of the tables.

2. Right-click the calibration curve and then click Overlay.

Figure 8-12 Overlay dialog

3. Select the tables to overlay with the current curve.

4. Click OK.

The software plots the curves for all selected tables on the same graph.

Calibration Curve Right-Click Menu
Right-click in the Calibration window or pane table to access the following options.

Note: To examine the curve for one table more closely, right-click on the curve and 
click Active Plot. Select the curve to be plotted on top.
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Sample Statistics
Use the Statistics window to view the statistics samples, typically for standards and QCs (quality 
controls). The data from each available batch in the Results Table opens in tabular form in the 
grid and a row of data is shown for each standard or QC concentration.

View the Statistics for Standards and Qcs
When viewing more than one Results Table, statistical information about the standards and QCs 
for additional batches in the Statistics window can be obtained. This allows the user to compare 
results between batches and look for trends in the standards or QCs.

1. With a Results Table open, click Tools > Statistics.

2. In the Statistics Metric list, select Concentration.

3. In the Analyte Name field, select an analyte.

4. In the Sample Type field, select Standard.

The results appear.

5. Look at the %CV and Accuracy columns. 

The %CV shows the coefficient of variance between the measurements of a single 
parameter, for example the area. Accuracy shows how close the plotted point is to 
the interperlated value. 

Figure 8-13 Calibration Curve Right-Click Menu 

Menu Function
Exclude (Include) Right-click the point and then click Exclude to exclude the point 

from the curve. Right-click the point and then click Include to 
include the dropped point.

Exclude All Analytes 
(Include All Analytes)

Right-click a point and then click Exclude All Analytes to exclude 
all the analytes from the curve. Right-click a point and then click 
Include All Analytes to include the points.

Show Peak Click to review an individual peak.

Overlay Overlays two graphs.

Active Plot Determines which plot is active.

Legend Shows the graph legend.

Log Scale X Axis* Click to use a log scale for the X axis. 

Log Scale Y Axis* Click to use a log scale for the Y axis.

Delete Pane Deletes the active pane.

Home Graph Scales the graph to its original size

* A log scale arranges the data points in a more manageable view so that the effect of all 
points can be monitored simultaneously. For this view, select Log Scale Y Axis versus 
Log Scale X and not just the log of one axis.
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6. If required, select the Display Low/High values check box and then examine the 
Low, High, and Mean for each row in the grid. Each row represents standards that 
have the same concentration levels.

7. Select another analyte.

The results appear on a per-analyte basis.

8. To check for Quality Control variations at the same concentration levels, select QC in 
the Sample Type field.

Compare Results Between Batches
The number of analytes and the analyte names must be the same for the data to be combined in 
the Statistics pane.

1. Open the Results Tables.

2. Click Tools > Statistics.

3. Do one of the following:

• To arrange the results by Results Table, in the Conc. as Rows list, select 
Group By Batch.

• To arrange the results in order of concentration, in the Conc. as Rows list, 
select Group By Concentration.

• To arrange the results in order of concentration, but without a row showing the 
statistics for each group or batch, in the Conc. as Rows list, select Group By 
Concentration (no All).

The software sorts the results. At the end of each batch or group, one or two 
additional rows appear: All (statistics for all results tables in that group) and Average 
(statistics on the statistics for that batch or group). 

Table 8-1 Integration Tab and Quantitation Wizard Icons 

Icon Name Function
Set parameters from 
Background Region

Use the selected peak.

Select Peak Use the selected background.

Manual Integration Mode Click to manually integrate peaks.

Show or Hide Parameters Click to toggle the peak-finding parameters between 
shown and hidden.

Show Active Graph Shows the analyte chromatogram only.

Show Both Analyte and IS Shows the analyte and its associated 
chromatogram (available only when an associated 
internal standard exists).
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Use Default View for Graph Returns to the preset (view all data) view (if, for 
example, the user has zoomed in on a 
chromatogram).

Table 8-2 Results Table Icons 

Icon Name Function
Sort Ascending by Selection Click to sort the selected column by ascending 

values.

Sort Descending by 
Selection

Sorts the selected column by descending values.

Lock or Unlock Column Locks or unlocks the selected column. A locked 
column cannot be moved.

Metric Plot by Selection Creates a metric plot from the selected column.

Show all Samples Shows all the samples in the Results Table.

Delete Formula Column Deletes formula columns.

Table 8-3 Icon Quick Reference: Quantitate Mode 

Icon Name Function
Add/Remove Samples Adds or removes samples from the Results Table.

Export as Text Saves the Results Table as a text file.

Modify Method Click to open a .wiff file.

Peak Review - Pane Opens peaks in a pane.

Peak Review - Window Opens peaks in a window.

Calibration - Pane Opens the calibration curve in a pane.

Calibration - Window Opens the calibration curve in a window.

Table 8-1 Integration Tab and Quantitation Wizard Icons  (Continued)

Icon Name Function
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Show First Peak Shows the first peak in the pane or window.

Show Last Peak Shows the last peak in the pane or window.

Show Audit Trail Shows the audit trail for the Results Table.

Clear Audit Trail Clears the audit trail for the Results Table.

Statistics Opens the Statistics window.

Report Generator Opens the Reporter software.

Table 8-3 Icon Quick Reference: Quantitate Mode  (Continued)

Icon Name Function
System User Guide

Document Number: D5030863 A

4500 Series of Instruments

 103 of 142



Analyzing and Processing Quantitative Data
4500 Series of Instruments

104 of 142

System User Guide

  Document Number: D5030863 A



A
Turbo V™ Ion Source User Reference
Use the ion source for electrospray ionization with the TurboIonSpray® probe, or for chemical 
ionization with the APCI (atmospheric pressure chemical ionization) probe. Applications for the 
ion source include qualitative method development and qualitative and quantitative analysis.

Introduction to the Ion Source
Figure A-1 shows the parts of the ion source.

WARNING! Toxic Chemical Hazard: Use the ion source only if you have 
knowledge of and training in the proper use, containment, and evacuation of 
poisonous or injurious materials used with the ion source. Any poisonous or 
injurious materials introduced into the equipment will be present in the ion 
source and exhaust output.

Figure A-1 Ion source components

Item Description
1 Sample tubing

1

2

12

3

4

1

5

6

7

8

9

10

11
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Turbo V™ Ion Source User Reference
Probes
Choose the probe and method most suitable for the compound in the sample stream flow.

The TurboIonSpray probe produces ions through ion evaporation. The APCI probe vaporizes the 
sample before inducing ionization through atmospheric pressure chemical ionization. This 
process is induced by a corona discharge needle as the ions pass through the ion source 
housing to the interface region.

All of the data acquired using the ion source is identified with an abbreviation representing the 
probe used to acquire the data (TIS for the TurboIonSpray probe, HN for the APCI probe).

TurboIonSpray® Probe

The TurboIonSpray probe is suited for LC/MS/MS analyses. The sensitivity that is achieved with 
this technique is dependent on both flow rate and analyte. At higher flow rates, ionization 
efficiency increases, resulting in improved sensitivity. Compounds with extremely high polarity 
and low surface activity usually show the greatest sensitivity increases. The TurboIonSpray 

2 Probe tower

3 X-axis adjustment knob used to position the probe on the horizontal axis for ion source 
sensitivity adjustments

4 Grounding union

5 One of two source latches that secure the ion source to the mass spectrometer

6 Guide pin

7 Window port

8 Turbo heater

9 Bronze retaining ring

10 Y-axis adjustment knob used to position the probe on the vertical axis for ion source 
sensitivity adjustments

11 Electrode adjustment nut

12 Sample tubing nut

Table A-1 Specifications of the Ion Source 

Parameter TurboIonSpray® probe APCI probe

Ion source temperature 
range

Probe temperature from ambient 
temperature to 750°C, depending on 
liquid flow

Probe temperature from 
50°C to 750°C, 
depending on liquid flow

Liquid chromatography Interfaces to any liquid chromatography system

Nebulizer gas (Gas 1)

Heater gas (Gas 2)

Refer to the Site Planning Guide for the mass spectrometer.

Figure A-1 Ion source components (Continued)

Item Description
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Turbo V™ Ion Source User Reference
technique is mild enough to be used with labile compounds, such as peptides, proteins, and 
thermally labile pharmaceuticals.

When the heater is turned off, the TurboIonSpray probe functions as a conventional IonSpray™ 
ion source. It also functions with flow rates from 5 µL/min to 3000 µL/min and it vaporizes 100% 
aqueous to 100% organic solvents.

APCI Probe

The APCI probe is suitable for:

• Ionization of compounds that do not readily form ions in solution. These are usually 
non-polar compounds.

• Creation of simple APCI spectra for MS/MS experiments.

• High-throughput analyses of complex and dirty samples. It is less sensitive to ion 
suppression effects.

• Rapid sample introduction by flow injection with or without an LC column

The APCI probe can accept the entire effluent, without splitting, at flow rates from 50 µL/min to 
3000 µL/min (through a wide bore column). It can vaporize volatile and labile compounds with 
minimal thermal decomposition. The rapid desolvation and vaporization of the droplets and 
entrained analyte minimizes thermal decomposition and preserves molecular identity for 
ionization by the corona discharge needle. Buffers are readily tolerated by the ion source without 
significant contamination and the flash vaporization of the sprayed effluent allows up to 100% 
water to be used without difficulty.

Figure A-2 Parts of the TurboIonSpray® probe

Item Description
1 Electrode adjustment nut (black collar) that adjusts the extension of the electrode tip

2 Bronze retaining ring that fastens the probe to the probe tower on the ion source 
housing

3 Electrode tip through which samples are sprayed into the sample inlet area of the ion 
source

3
1 2
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Gas and Electrical Connections
Gas and high-voltage electrical connections enter through the front plate of the interface and 
connect internally through the ion source housing. When the ion source is installed on the mass 
spectrometer, all of the electrical and gas connections are made.

Ion Source Latch
A latch disables the high-voltage power supply for the mass spectrometer and the source 
exhaust system if:

• The ion source housing is not installed or is improperly installed. 

• A probe is not installed. 

• The mass spectrometer senses a gas fault. 

Source Exhaust System

A passive pressure exhaust system removes ion source gases through a drain port without 
introducing chemical noise. The drain port connects through a drain chamber and a source 
exhaust pump to a drain bottle, and from there to a customer-supplied exhaust ventilation 
system. For more information on the requirements for the source exhaust system, refer to the 
Site Planning Guide for the mass spectrometer.

Figure A-3 Parts of the APCI probe

Item Description
1 Electrode adjustment nut (black collar) that adjusts the extension of electrode tip

2 Bronze retaining ring that fastens the probe to the probe tower on the ion source 
housing

3 Electrode tip through which samples are sprayed into the sample inlet area of the ion 
source

WARNING! Toxic Chemical Hazard: Be sure to use the source exhaust system to 
safely remove sample vapor exhaust from the laboratory environment. For 
requirements for the source exhaust system, refer to the Site Planning Guide for 
the mass spectrometer.

21
3
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A pressure switch mounted on the source exhaust pump measures the pressure in the source 
exhaust line. If the pressure in the line rises above the set point while the probes are installed, 
the high-voltage power supply is turned off. 

Installation
The interior of the ion source is visible through the tempered glass windows on the side and end 
of the ion source housing. The ion source housing is connected to the vacuum interface housing 
and is held in position by two source latches. 

Install the Ion Source
Install the probe in the ion source housing before installing the ion source. Always remove the ion 
source from the mass spectrometer before exchanging probes. Refer to Remove the Ion Source 
on page 117.

When the ion source is installed, the mass spectrometer recognizes the ion source and displays 
the ion source identification in the software.

Install the Probe in the Ion Source Housing

If the probe is not properly installed in the ion source housing, then high-voltage power for the 
mass spectrometer and source exhaust system is turned off.

WARNING! Toxic Chemical Hazard: Vent the source exhaust system to an 
external fume hood or an external vent to prevent hazardous vapors from being 
released into the laboratory environment. 

WARNING! Electrical Shock Hazard: Install the ion source on the mass 
spectrometer as the last step in this procedure. High voltage is present when the 
ion source is installed on the equipment. 

Required Parts (supplied)
• Ion source housing assembly

• Probe

• Ion source hardware kit (Do not discard the empty package. Use it to store the ion source 
when not in use.)

• Adjust the black electrode adjustment nut on the probe to move the electrode tip inside the 
electrode tube. 
For optimum stability and performance, the electrode tip should extend between 0.5 mm and 
1.0 mm from the end of the probe.

WARNING! Electrical Shock Hazard: Make sure that the ion source housing is 
completely disconnected from the mass spectrometer before proceeding.
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Caution: Potential Equipment Damage: Do not let the protruding electrode tip touch any 
part of the ion source housing, to avoid damaging the probe. 

Caution: Potential Equipment Damage: Make sure that the corona discharge needle tip is 
turned away from the orifice when using the TurboIonSpray probe.

1. Insert the probe into the tower. 

2. Align the hole on the probe with the alignment pin at the top of the ion source 
housing. Refer to Figure A-1 on page 105.

3. Gently push down on the probe so that the contacts engage with those in the tower. 

4. Turn the bronze retaining ring over the probe and push it down to engage its threads 
with the threads on the tower.

5. Tighten the ring until it is finger-tight.

When using the APCI probe, make sure that the corona discharge needle tip is 
pointed toward the orifice.

Connect the Source Tubing

1. Insert a 30 cm piece of red PEEK tubing into the sample tubing nut.

2. Install the sample tubing nut on the fitting at the top of the probe.

3. Tighten the sample tubing nut until it is finger-tight.

Install the Ion Source

1. Make sure that the source latches on the side of the ion source are pointing up in the 
12:00 position.

2. Align the ion source with the vacuum interface, making sure that the latches on the 
ion source are aligned with the sockets in the vacuum interface.

3. Push the ion source gently against the vacuum interface and then rotate the ion 
source latches, shown in Figure A-1 on page 105, fully downwards to lock the ion 
source into place.

Connect the Sample Tubing and Cables

WARNING! Electrical Shock Hazard: When installing the ion source, install the 
probe before installing the ion source on the mass spectrometer. 

WARNING! Toxic Chemical Hazard: Make sure that the sample tubing nut is 
tightened properly before operating this equipment. If the sample tubing nut is 
not tight, the sample may leak, and you may be exposed to dangerous chemicals.

WARNING! Electrical Shock Hazard: Do not bypass the grounding 
union connection. The grounding union provides safety grounding 
between the mass spectrometer and the sample introduction device.
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1. Connect red PEEK tubing from the sample supply device to the grounding union on 
the ion source.

2. Connect the other end of the red PEEK tubing to the grounding union. 

Optimization
Optimize the ion source whenever the analyte, flow rate, or mobile phase composition changes.

Use appropriate analytical procedures and practices to minimize external dead volumes. Prefilter 
samples so that the capillary tubing in the sample inlets is not blocked by particles, precipitated 
samples, or salts.

Optimize the TurboIonSpray® Probe 
Optimize performance while injecting a known compound and monitor the signal of the known 
ion. Adjust the parameters to maximize the signal-to-noise ratio and signal stability.

Caution: Potential Equipment Damage: If the LC system connected to the mass 
spectrometer is not controlled by the Analyst software, then do not leave the mass 
spectrometer unattended while in operation. The LC system can flood the ion source 
housing when the mass spectrometer goes into Standby mode.

Adjust the TurboIonSpray Probe Position

At low flow rates, the probe can be adjusted to its lowest Y-axis position. For high flow rates, 
position the probe higher than the orifice. The curtain plate orifice should remain clear of solvent 
or solvent droplets at all times.

For multiply-charged proteins and peptides introduced at a few microliters per minute, position 
the sprayer nozzle higher than the curtain plate orifice.

Tip! Refer to Figure A-1 on page 105 for a picture on the parts referenced 
in this procedure.

Note: If the IonSpray voltage is too high, a corona discharge can occur. It is visible as a 
blue glow at the tip of the TurboIonSpray probe. This will result in decreased sensitivity 
and stability of the ion signal.

Table A-2 Typical Values for Optimizing the TurboIonSpray Probe

Parameters LC flow rate Operational 
range

5 µL/min to 
50 µL/min

200 µL/min 1000 µL/
min

5 µL/min to 
3000 µL/min

Probe X-axis position 3 mm to 8 mm 0 mm to 10 mm

Probe Y-axis position 5 mm to 10 mm 0 mm to 5mm 0 mm to 13 mm

The optimal X-axis position is within 0 mm to 3 mm on either side of the orifice. 

The optimal Y-axis position is within 3.0 mm to 7.0 mm of the orifice. 
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1. Before starting the sample flow, let the ion source warm up for 30 minutes or until the 
ion source housing is warm to the touch. 

The 30-minute warm-up stage prevents solvent vapors from condensing in the cold 
probe. 

2. In the Analyst® software, in Tune and Calibrate mode, double-click Manual Tune.

3. Open the method to optimize the ion source.

4. Look through the window of the ion source housing to view the position of the probe.

5. Set the X-axis adjustment knob to 5 and the Y-axis adjustment knob to 5.

6. Infuse or inject the sample.

7. Monitor the signal in the software.

8. Use the X-axis adjustment knob to adjust the probe position in small increments until 
the best signal or signal-to-noise ratio is achieved.

The probe may optimize slightly to either side of the orifice.

9. Use the Y-axis adjustment knob to adjust the probe position in small increments until 
the best signal or signal-to-noise ratio is achieved.

10. Adjust the black electrode adjustment nut on the probe to move the electrode tip 
relative to the sprayer tube. 

Typically, the optimum extension of the electrode from the sprayer tube is 0.5 mm to 
1.0 mm. After the probe is optimized, it needs only minor adjustment. 

Optimize Gas 1, Gas 2, Curtain Gas, and IonSpray Voltage

Optimize nebulizer gas (Gas 1) for best signal stability and sensitivity. The heater gas (Gas 2) 
aids in the evaporation of solvent, which helps to increase the ionization of the sample. However, 
too high a temperature can cause premature vaporization of the solvent at the TurboIonSpray 
probe tip, especially if the probe is too low, which will result in signal instability and a high 
chemical background noise. Similarly, a high heater gas flow could produce a noisy or unstable 
signal.

1. On the Source/Gas tab in the Tune Method Editor, type a starting value for Ion 
Source Gas 1 (GS1).

Typical values are between 40 psi and 60 psi for GS1.

2. Type a starting value for Ion Source Gas 2 (GS2).

Tip! It is easier to optimize signal and signal-to-noise with FIA or on-
column injections.

Note: The vertical position of the probe depends on flow rate. At low flow 
rates, the probe should be closer to the orifice. At higher flow rates, the 
probe should be farther away.

WARNING! Toxic Chemical Hazard: Make sure that the electrode tip 
extends past the end of the probe, to prevent the escape of hazardous 
vapor from the ion source.
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Typical values are between 30 psi and 50 psi for GS2.

3. Type a starting value for IonSpray Voltage (IS) or IonSpray Voltage Floating 
(ISVF).

4. Adjust GS1 and GS2 in increments of 5 psi until the best signal or signal-to-noise 
ratio is achieved.

5. In the Curtain Gas (CUR) field, type 20.

6. Increase CUR to the highest possible gas flow rate without a noticeable signal drop.

7. Adjust IS or ISVF in increments of 100 V to maximize signal to noise.

Optimize the Turbo Heater Temperature

The quantity and type of sample affects the optimal TurboIonSpray probe temperature. At higher 
flow rates the optimal temperature increases. Normal optimization is usually performed in 
increments of 50°C.

1. On the Source/Gas tab in the Tune Method Editor, type a starting value for 
Temperature (TEM).

2. Wait for the signal to stabilize, to make sure that the ion source is at the correct 
temperature.

3. Adjust the temperature parameter as required until the best signal or signal-to-noise 
ratio is achieved.

Optimization Tips

• Use the highest temperature possible when optimizing compounds. A temperature 
of 700°C is common for many compounds. High temperatures help keep the ion 
source clean and reduce background noise.

• Use the highest Curtain Gas flow rate (CUR) possible without decreasing the signal. 
This helps to:

• Prevent penetration of the Curtain Gas flow, which can produce a noisy signal

• Prevent contamination of the orifice

• Increase the overall signal-to-noise ratio

• Direct the liquid spray from the TurboIonSpray probe away from the orifice in order 
to:

• Prevent contamination of the orifice

• Prevent piercing of the Curtain Gas flow, which can create an unstable signal

• Prevent electrical shorting due to the presence of the liquid

Note: Gas 2 is used with higher flow rates typical with an LC system and in 
conjunction with increased temperature. 

WARNING! Toxic Chemical Hazard: Vent the source exhaust system to an 
external fume hood or an external vent to prevent hazardous vapors from being 
released into the laboratory environment.
System User Guide

Document Number: D5030863 A

4500 Series of Instruments

 113 of 142



Turbo V™ Ion Source User Reference
• Use the lowest IonSpray voltage possible without losing signal. Focus on signal-to-
noise and not just signal.

Optimize the APCI Probe
Optimize performance by injecting a known compound and monitoring the signal of the known 
ion. Adjust the parameters to maximize the signal-to-noise ratio.

Warm up the APCI Probe

Caution: Potential Equipment Damage: If the LC system connected to the mass 
spectrometer is not controlled by the Analyst software, then do not leave the mass 
spectrometer unattended while in operation. The LC system can flood the ion source 
housing when the mass spectrometer goes into Standby mode.

1. On the Source/Gas tab in the Tune Method Editor, in the Curtain Gas (CUR) field, 
type 20. 

Operate the APCI probe with the highest Curtain Gas flow rate possible without a 
noticeable signal drop.

2. In the Ion Source Gas 1 (GS1) field, type 20.

3. In the Temperature (TEM) field, type 400.

4. Before starting the sample flow, let the ion source warm up for 30 minutes or until the 
ion source housing is warm to the touch. 

The 30-minute warm-up stage prevents solvent vapors from condensing in a cold 
probe. 

5. Turn on the pump.

6. Wait until the APCI probe reaches a temperature at which the solvent mist is cleared 
from the ion source housing (about 10 minutes).

Adjust the Corona Discharge Needle

When using the APCI probe, make sure that the corona discharge needle is pointing toward the 
orifice.

1. Use the slotted screwdriver to rotate the plastic screw on the top of the needle.

Table A-3 Typical Values for Optimizing the APCI Probe

Parameter Typical value Operational range
Probe X-axis position 5 mm Scale 0 mm to 10 mm

Probe Y-axis position 5 mm Scale 0 mm to 13 mm

The optimal X-axis position is within 0 mm to 2 mm on either side of the orifice. 

The optimal probe Y-axis position is within 3.0 mm to 7.0 mm of the orifice.

WARNING! Electrical Shock Hazard: Follow this procedure to avoid contact with 
the high voltages applied to the corona discharge needle and the curtain plate.
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2. Look through the glass window to make sure that the needle is aligned with the tip 
facing the orifice.

Adjust the APCI Probe Position

Make sure that the curtain plate orifice remains clear of solvent or solvent drops at all times. The 
position of the probe relative to the curtain plate orifice affects sensitivity and signal stability. The 
probe vertical (Y-axis) position is dependent on flow rate. For low flow rates, move the probe to 
its lowest position. For higher flow rates, move the probe above the curtain plate orifice. 

1. In Tune and Calibrate mode, double-click Manual Tune.

2. Run the method to optimize the ion source.

3. Look through the window of the ion source housing to view the position of the probe.

4. Set the X-axis adjustment knob to 5 and the Y-axis adjustment knob to 5.

5. Use FIA to inject the sample or use a Tee connection with a syringe to infuse the 
sample at a high flow rate.

6. Monitor the signal in the Analyst software.

7. Use the X-axis adjustment knob to adjust the probe in small increments until the best 
signal or signal-to-noise ratio is achieved.

8. Use the Y-axis adjustment knob to adjust the probe in small increments until the best 
signal or signal-to-noise ratio is achieved. 

The APCI probe optimizes toward the orifice plate. After the probe is optimized, it 
needs only minor adjustment. 

Optimize the Nebulizer Current

The ion source is controlled by current and not by voltage. Select the appropriate current for the 
acquisition method, regardless of ion source selection position. Use the PEEK adjustment knob 
to position the corona discharge needle so that the tip of the needle points right at the center of 
the probe.

• Start with a Nebulizer Current (NC) value of 1 and increase until the best signal or 
signal-to-noise ratio is achieved.

The NC (Nebulizer Current) applied to the corona discharge needle usually 
optimizes between 1 µA and 5 µA in positive mode. If there are no changes in signal 
when increasing the current, then leave the current at the lowest value that provides 
the best signal or signal-to-noise ratio.

Tip! It is easier to optimize signal and signal-to-noise with FIA or on-
column injections.
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Optimize the APCI Probe Temperature

The quantity and type of solvent affects the optimal APCI probe temperature. At higher flow 
rates, the optimal temperature increases.

Optimization is usually performed in increments of 50°C.

1. On the Source/Gas tab in the Tune Method Editor, type a starting value for the 
Temperature (TEM).

2. Adjust the temperature parameter as required until the best signal or signal-to-noise 
ratio is achieved.

Maintenance
To determine how often to clean the ion source or perform preventive maintenance, consider the 
following:

• Compounds tested

• Cleanliness of the preparation methods

• Amount of time an idle probe contains a sample

• Overall system run time

These factors can cause changes in mass spectrometer performance, indicating that 
maintenance is required.

Perform periodic gas leakage tests and general maintenance inspections to be sure of safe 
operation of the system. Clean the ion source regularly to keep it in good working condition.

Caution: Potential Instrument Damage: Use only the recommended cleaning method to 
avoid damaging the equipment.

Clean the Probes
Flush the ion source periodically, regardless of the type of compounds sampled. Do this by 
setting up a method in the Analyst software specifically for performing a flushing operation.

1. Switch to a mobile phase that is 50:50 water:acetonitrile or 50:50 water:methanol.

WARNING! Toxic Chemical Hazard: Vent the source exhaust system to an 
external fume hood or an external vent to prevent hazardous vapors from being 
released into the laboratory environment.

Required Tools
• 1/4 inch open-ended wrench

• 9/64 inch Allen key (supplied)

• 5 mm Allen key

• 2.5 mm Allen key

• Phillips screwdriver

• Slotted screwdriver
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2. In the Analyst software, set TEM between 500 and 600, GS1 and GS2 to at least 40, 
and Curtain Gas™ flow to the highest setting possible. 

3. Wait until the TEM setpoint is reached.

4. Infuse or inject mobile phase through the sample tubing and probe at 1 mL/min for 
about 10 to 15 minutes.

5. Make sure that the probe and sample tubing are flushed thoroughly.

Remove the Ion Source
Always remove the ion source from the mass spectrometer before you perform any maintenance 
on the ion source or exchange probes.

1. Stop any ongoing scans.

2. Shut down the sample stream.

3. Using the Analyst software, put the mass spectrometer in Standby mode. Refer to 
the Analyst software Help.

4. Let the ion source cool for at least 10 minutes.

5. Disconnect the sample tubing from the grounding union.

6. Turn the two source latches upward to release the ion source.

7. Pull the ion source gently away from the vacuum interface.

8. Put the ion source on a clean, secure surface.

Remove the Probe
Always remove the ion source from the mass spectrometer before you perform any maintenance 
on the probe or change probes.

1. Remove the ion source from the mass spectrometer. Refer to Remove the Ion 
Source.

2. Loosen the 1/8-in. sample tubing nut and remove the sample tubing from the probe.

3. Loosen the bronze retaining ring that fastens the probe to the ion source housing.

4. Gently pull the probe straight up out of the tower. Do not let the tip of the probe touch 
anything during removal or storage. 

5. Put the probe on a secure, clean surface.

WARNING! Hot Surface Hazard: Surfaces of the ion source become hot during 
operation. Let the ion source cool for at least 10 minutes before starting any 
maintenance procedures.

WARNING! Electrical Shock Hazard: Disconnect the source from the mass 
spectrometer before starting any maintenance procedures.
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Clean the Electrode Tube
Clean the electrode tube periodically, or when performance decreases.

This procedure applies to both the TurboIonSpray® and APCI probes. Use this procedure to 
remove the electrode tube for cleaning. If the electrode tube cannot be cleaned, then use this 
procedure to replace it with a new part.

1. Remove the ion source from the mass spectrometer.

2. Remove the probe from the ion source. Refer to Remove the Ion Source on 
page 117 and Remove the Probe on page 117.

3. Remove the electrode adjustment nut. Hold the probe with the tip pointing 
downwards so the spring remains inside the probe as the electrode tube is 
withdrawn. Refer to Figure A-4.

4. Pull the PEEK union and the attached electrode tube from the probe. Refer to 
Figure A-4.

5. Use the 1/4 inch open-ended wrench to remove the retaining nut that holds the 
electrode tube in the PEEK union.

WARNING! Electrical Shock Hazard: Remove the ion source from the mass 
spectrometer before starting any maintenance procedures.

Figure A-4 Probe - expanded view

Item Description
1 Electrode adjustment nut

2 PEEK union

3 Spring

4 Bronze retaining ring

5 Electrode tip

6 Sprayer tube

7 Electrode tube

8 1/4-inch retaining nut

7

3
2

4

8
1

6

5
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6. Remove the electrode tube from the retaining nut.

7. Clean the electrode tube with a 50:50 methanol:water solution, by running the 
solution through the electrode tube or by soaking the tube in an ultrasonic bath.

Replace the Electrode

1. Insert the electrode tube into the retaining nut and then into the PEEK union fitting. 

Make sure that the electrode tube is inserted as far into the PEEK union fitting as it 
will go. If there is a gap between the electrode tube and its seat inside the union 
fitting, a dead sample volume may occur. 

2. Align the electrode tube with the narrow opening in the sprayer tube, and then insert 
the PEEK union fitting and attached electrode tube into the probe. Be careful not to 
bend the electrode tube. 

3. Make sure that the spring is still inside the probe and then tighten the electrode 
adjustment nut. 

4. Insert the probe into the tower, taking care not to allow the tip of the probe to touch 
any part of the ion source housing.

5. Push down the bronze retaining ring to engage its thread with the thread on the ion 
source housing and then tighten the ring. 

6. Insert the sample tubing into the sample tubing nut, insert the sample tubing nut into 
the fitting at the top of the probe, and then tighten the sample tubing nut until it is 
finger-tight.

7. Install the ion source on the mass spectrometer. Refer to Install the Ion Source on 
page 109.

8. Adjust the electrode tip to specification. Refer to Adjust the Electrode Tip Extension 
on page 119.

Adjust the Electrode Tip Extension
The electrode tip extension should be adjusted for best performance. The optimal setting is 
compound-dependent. The distance that the electrode tip extends affects the shape of the spray 
cone, and the cone shape affects mass spectrometer sensitivity.

• Adjust the black electrode adjustment nut on the top of the probe to extend or retract 
the electrode tip. The electrode tip should extend between 0.5 mm and 1.0 mm from 
the end of the probe as shown in Figure A-5.

WARNING! Toxic Chemical Hazard: Make sure that the electrode tip extends past 
the end of the probe, to prevent the escape of hazardous vapor from the ion 
source.
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Replace the Corona Discharge Needle 
The corona discharge needle tip may become so corroded that it must be cut off from the corona 
discharge needle. If this occurs, replace the corona discharge needle. 

1. Remove the ion source and probe from the mass spectrometer, refer to Remove the 
Ion Source on page 117 and Remove the Probe on page 117.

Figure A-5 Electrode tip extension adjustment

Item Description
1 Probe

2 Electrode

WARNING! Electrical Shock Hazard: Remove the ion source from the mass 
spectrometer before starting any maintenance procedures.

WARNING! Piercing Hazard: The tip of the needle is extremely sharp. Take care 
to handle it safely.

0.5 - 1 mm

1

2
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2. Hold the corona discharge needle tip and, with the other hand, turn the corona 
discharge needle adjustment knob counter-clockwise to remove it. 

3. Gently pull the corona discharge needle down through the exhaust chimney to 
remove it.

4. Insert the new needle through the exhaust chimney into the ceramic sleeve as far as 
it will go.

5. While holding the corona discharge needle tip, install and tighten the corona 
discharge needle adjustment knob.

6. Insert the probe, and then install the ion source housing on the mass spectrometer. 
Refer to Install the Ion Source on page 109.

Replace the Sample Tubing
Use the following procedure to replace the sample tubing if it has a blockage.

1. Stop the sample flow and make sure that any remaining gas has been removed 
through the source exhaust system. 

2. Remove the ion source. Refer to Remove the Ion Source on page 117.

3. Disconnect the sample tubing from the probe and the union.

Figure A-6 Removing the corona discharge needle

Item Description
1 Ceramic sleeve

2 Corona discharge needle tip

3 Exhaust chimney

3

2

1
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4. Replace the sample tubing with the same length of tubing used previously.

5. Install the ion source. Refer to Install the Ion Source on page 109.

6. Resume the sample flow.

Troubleshooting
Table A-4 Troubleshooting 

Symptom Possible cause Solution
The Analyst® software reports 
that the mass spectrometer is in 
Fault status.

The probe is not installed.

The probe is not connected 
securely.

Install the probe. Refer to 
Install the Probe in the Ion 
Source Housing on 
page 109.

Remove and replace the 
probe. Tighten the probe 
connection bronze ring 
securely. Refer to Remove 
the Probe on page 117 and 
Install the Probe in the Ion 
Source Housing on 
page 109.

The Analyst software indicates 
that the APCI probe is in use, 
but the TurboIonSpray® probe is 
installed.

F3 fuse is blown. Contact an FSE.

The spray is not uniform. The electrode is blocked. Clean or replace the 
electrode. Refer to Clean the 
Electrode Tube on page 118.

Sensitivity is poor. Solvent vapor or other 
unknown compounds are 
present in the analyzer region.

Optimize the Curtain Gas™ 
flow. Refer to Optimize the 
TurboIonSpray® Probe on 
page 111 or Optimize the 
APCI Probe on page 114.

During testing, the ion source 
fails to meet specifications.

The mass spectrometer has 
not passed the installation 
tests.

The test solution was not 
prepared correctly.

Perform installation tests on 
the mass spectrometer with 
the default source.

Confirm that the test 
solutions were prepared 
correctly.

If the problem cannot be 
resolved, contact an FSE.

Background noise is high. Temperature (TEM) is too 
high.

Heater gas flow rate (GS2) is 
too high.

Optimize the temperature.

Optimize heater gas flow.
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Consumables
The following tables list the orderable parts for the Turbo V™ ion source. The parts are available 
in the Consumables Kit for the mass spectrometer (PN 1026540).

Arcing or sparks occur. The position of the corona 
discharge needle is incorrect.

Turn the corona discharge 
needle toward the curtain 
plate, and away from the 
stream of heater gas. Refer 
to Adjust the Corona 
Discharge Needle on 
page 114.

Table A-5

Part # Description Quantity Details
016316 TUBE*1 16 OD X .005 BORE cm Red PEEK tubing (0.005-inch bore)

016325 FITTING*PEEK 10 32 X 1 16 
INCH

1 Brown PEEK fitting

016485 TUBE* 1 16 OD-0.0025 INCH ID 
PEEK

cm Tan PEEK tubing (0.0025-inch bore)

019675 FITTING*TEE INSERT .25 
BORE

1 TEE insert (0.25 mm bore)

025388 ELECTRODE*N 1 APCI electrode

025392 ELECTRODE*T 1 TurboIonSpray® electrode

Table A-6

Part # Description Quantity Details
027947 FRU*KIT NEB NEEDLE 1 Corona discharge needle

027950 FRU*KIT ELECTRODE NEB 1 APCI electrode kit

1003263 FUSE*4A 250v 5X20 LONG 
DELAY

1 F3 fuse T4A 250 V, 5 mm × 20 mm time 
delay (Not used for AB SCIEX 
TripleTOF™ 5600 systems.)

Table A-7

Part # Description Quantity Details
027460 OPT*ASSY NEB 1 APCI probe assembly

027461 OPT*ASSY TURBO 1 TurboIonSpray® probe assembly

Table A-4 Troubleshooting  (Continued)

Symptom Possible cause Solution
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B
4500 Series Instrument Requirements and 
Parameters
This appendix includes electrical and gas requirements and instrument parameters for the 4500 
series instruments.

Electrical and Gas Requirements
The following table contains the values for nominal input voltage, input voltage fluctuation, 
frequency, maximum input current and maximum input power, where appropriate.

The following table contains the gas requirements for the 4500 series of instruments.

Instrument Parameters
The following table contains generic parameters for the 4500 series of instruments. The first 
number under each scan type is the preset value; the range of numbers is the accessible range 
for each parameter.

Table B-1 Electrical Requirements

Component Values
Instrument 200 to 240 V, ±10% of nominal, 50/60 Hz, 10 A, 1000 VA

Roughing pump (Leybold) 200 to 240 V, ±10% of nominal, 50/60 Hz, 4.2 A (50 Hz), 4.7 A 
(60 Hz), 2420 VA (50 Hz), 2250 (60 Hz)

Roughing pump (Varian) 200 to 240 V, ±10% of nominal, 50/60 Hz, 1.76 A, 1200 VA

Instrument bench 100 to 240 V, ±10% of nominal, 50/60 Hz, 1 A, 240 VA

Computer 115/230 V, ±10% of nominal, 50/60 Hz, 6/3 A, 690 VA

Monitor 100 to 240 V, +6/–10% of nominal, 50/60 Hz, 1.5 A, 360 VA

Table B-2 Gas Requirements

Gas Description Requirements
Gas 1/Gas 2 Zero air Zero grade air at 100 psi (max.); flow 

rate of 22 L/min.

Curtain Gas™ supply; 
CAD gas

UHP (ultra high purity) 
nitrogen (N2)

UHP N2 at 60 psi (max.); flow rate of 
10 L/min.

Source exhaust House air, zero air, or UHP 
N2

House air, zero air, or UHP N2 at 
55 psi; flow rate of 8 L/min. Do not 
operate below 55 psi.
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Table B-3 4500 Series Instrument Parameters

Access ID Positive ion mode Negative ion mode
Q1 Q3 MS/MS Q1 Q3 MS/MS

CUR(6) 20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

20

10 to 55

CUR(1)(2)(3)(4)
(5)

10

10 to 55

10

10 to 55

10

10 to 55

10

10 to 55

10

10 to 55

10

10 to 55

CAD(a) 0

Fixed

6

Fixed

Medium

Low, 
Medium, 
High

0

Fixed

6

Fixed

Medium

Low, 
Medium, 
High

CAD(b) 0

Fixed

5

Fixed

9 

0 to 12

0

Fixed

5

Fixed

9 

0 to 12

IS(1)(2) 5500

0 to 5500

5500

0 to 5500

5500

0 to 5500

–4500

–4500 to 0

–4500

–4500 to 0

–4500

–4500 to 0

IS(5)

Ion Transfer 
Voltage

1500

0 to 2500

1500

0 to 2500

1500

0 to 2500

–1500

–2500 to 0

–1500

–2500 to 0

–1500

–2500 to 0

IS(6) 1000

0 to 4000

1000

0 to 4000

1000

0 to 4000

–1000

–4000 to 0

–1000

–4000 to 0

–1000

–4000 to 0

NC(3)(4) 3

0 to 5

3

0 to 5

3

0 to 5

–3

–5 to 0

–3

–5 to 0

–3

–5 to 0

TEM(2)(3)(4)(5) 0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

0

0 to 750

DP(a) 200

0 to 300

100

0 to 300

100

0 to 300

–100

–300 to 0

–100

–300 to 0

–100

–300 to 0

DP(b) 130

0 to 300

130

0 to 300

120

0 to 300

–60

–300 to 0

–60

–300 to 0

–150

–300 to 0

EP 10

2 to 15

10

2 to 15

10

2 to 15

–10

–15 to –2

–10

–15 to –2

–10

–15 to –2

CEM(a) 1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

1800

0 to 3300

CEM(b) 2000

0 to 3300

2000

0 to 3300

2000

0 to 3300

2000

0 to 3300

2000

0 to 3300

2000

0 to 3300

(1)IonSpray™ ion source (2)TurboIonSpray® ion source (3)Heated Nebulizer 
(4)DuoSpray™ ion source, 1=TIS, and 2=HN (5)PhotoSpray® ion source (6) NanoSpray® 
ion source (a) AB SCIEX QTRAP® 4500 system (b) AB SCIEX Triple Quad™ 4500 system
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GS1(a) 20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

20

0 to 90

GS1(b) 15

0 to 90

15

0 to 90

15

0 to 90

15

0 to 90

15

0 to 90

15

0 to 90

GS2 0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

0

0 to 90

IHT 150

0 to 250

150

0 to 250

150

0 to 250

150

0 to 250

150

0 to 250

150

0 to 250

sdp 1

1 or 2

1

1 or 2

1

1 or 2

1

1 or 2

1

1 or 2

1

1 or 2

IQ1

(IQ1 = Q0 + 
offset)

Q0 + (-0.5) Q0 + (-0.5) Q0 + (-0.5) Q0 + 0.5 Q0 + 0.5 Q0 + 0.5

ST

(ST = Q0 + 
offset)

Q0 + (-8)

-12 to -5

Q0 + (-8)

-12 to -5

Q0 + (-8)

-12 to -5

Q0 + 8

12 to 5

Q0 + 8

12 to 5

Q0 + 8

12 to 5

IE1(a)

(IE1 = Q0 - 
RO1)

1.6

0 to 3

n/a 2

0 to 3

-1

-3 to 0

n/a -1

-5 to 0

IE1(b)

(IE1 = Q0 - 
RO1)

0.9

0 to 3

n/a 0.9

0 to 3

-1

-3 to 0

n/a -1

-5 to 0

IQ2(a)

(IQ2 = Q0 + 
offset)

Q0 + (-10) Q0 + (-11) Q0 + (-10) Q0 + 11 Q0 + 11 Q0 + 15

IQ2(b)

(IQ2 = Q0 + 
offset)

Q0 + (-12) Q0 + (-12) Q0 + (-12) Q0 + (-10) Q0 + 10 Q0 + 10

RO2(a) -20

Fixed

-20

Fixed

n/a 20

Fixed

20

Fixed

n/a

RO2(b) -22

Fixed

-20

Fixed

n/a 18

Fixed

20

Fixed

n/a

Table B-3 4500 Series Instrument Parameters (Continued)

Access ID Positive ion mode Negative ion mode
Q1 Q3 MS/MS Q1 Q3 MS/MS

(1)IonSpray™ ion source (2)TurboIonSpray® ion source (3)Heated Nebulizer 
(4)DuoSpray™ ion source, 1=TIS, and 2=HN (5)PhotoSpray® ion source (6) NanoSpray® 
ion source (a) AB SCIEX QTRAP® 4500 system (b) AB SCIEX Triple Quad™ 4500 system
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CE(a)

(CE = Q0 - 
RO2)

n/a n/a 30

5 to 180

n/a n/a -30

-180 to -5

CE(b)

(CE = Q0 - 
RO2)

n/a n/a 53

5 to 180

n/a n/a -40

-180 to -5

ST3

(ST3 = RO2 + 
offset)

n/a n/a n/a n/a n/a n/a

CXP(a)

(CXP = RO2 - 
ST3)

n/a 15

0 to 55

15

0 to 55

n/a -15

-55 to 0

-15

-55 to 0

CXP(b)

(CXP = RO2 - 
ST3)

n/a 9

0 to 55

27

0 to 55

n/a -17

-55 to 0

-12

-55 to 0

RO3 -50

Fixed

n/a n/a 50

Fixed

n/a n/a

IE3(a) n/a 1.5

0 to 5

1.8

0 to 5

n/a -1.100

-5 to 0

-1

-5 to 0

IE3(b) n/a 2

0 to 5

1.5

0 to 5

n/a -2.500

-5 to 0

-1.2

-5 to 0

DF(a) -100

Fixed

-100

Fixed

-100

Fixed

100

Fixed

100

Fixed

100

Fixed

DF(b) -250

Fixed

-250

Fixed

-250

Fixed

150

Fixed

150

Fixed

150

Fixed

Table B-4 QTRAP 4500 System Parameters for LIT Scan Types Only

Access ID Positive Ion Mode Negative Ion Mode

CUR(6) 20

10 to 55

20

10 to 55

CUR(1)(2)(3)(4)(5) 20

10 to 55

20

10 to 55

Table B-3 4500 Series Instrument Parameters (Continued)

Access ID Positive ion mode Negative ion mode
Q1 Q3 MS/MS Q1 Q3 MS/MS

(1)IonSpray™ ion source (2)TurboIonSpray® ion source (3)Heated Nebulizer 
(4)DuoSpray™ ion source, 1=TIS, and 2=HN (5)PhotoSpray® ion source (6) NanoSpray® 
ion source (a) AB SCIEX QTRAP® 4500 system (b) AB SCIEX Triple Quad™ 4500 system
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CAD High

Low; Medium; High

High

Low; Medium; High

IS(1)(2) 5500

0 to 5500

-4500

-4500 to 0

IS(5) 1500

0 to 2500

-1500

-2500 to 0

IS(6) 1000

0 to 4000

-1000

-4000 to 0

NC(3)(4) 3

0 to 5

–3

–5 to 0

TEM(2)(3)(4)(5) 0

0 to 750

0

0 to 750

DP 100

0 to 300

–100

–300 to 0

EP 10

2 to 15

–10

–15 to –2

AF2 0.100

0 or 1

0.100

0 or 1

AF3 Mass-Speed Dependent

0 to 10

Mass-Speed Dependent

0 to 10

EXB Mass-Speed Dependent

–165 to 0

Mass-Speed Dependent

0 to 165

CEM 1800

0 to 3300

1800

0 to 3300

GS1 20

0 to 90

20

0 to 90

GS2 0

0 to 90

0

0 to 90

CES 0

0 to 50

0

0 to 50

CE

(Q0 - ROS)

10

5 to 180

-30

-180 to -10

Table B-4 QTRAP 4500 System Parameters for LIT Scan Types Only (Continued)

Access ID Positive Ion Mode Negative Ion Mode
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IHT 150

0 to 250

150

0 to 250

sdp 1

1 or 2

1

1 or 2

(1)IonSpray™ ion source (2)TurboIonSpray® ion source (3)Heated Nebulizer 
(4)DuoSpray™ ion source, 1=TIS, and 2=HN (5)PhotoSpray® ion source (6) NanoSpray® 
ion source

Table B-4 QTRAP 4500 System Parameters for LIT Scan Types Only (Continued)

Access ID Positive Ion Mode Negative Ion Mode
4500 Series of Instruments

130 of 142

System User Guide

  Document Number: D5030863 A



C
Calibration Ions and Solutions
a

Table C-1 Tuning Frequency

Calibration Resolution Optimization

Scan Type Frequency Manual/
Automated

Frequency Manual/Automated

Q1 and Q3 3 to 6 months Both 3 to 6 months Both

LIT Every 2 weeks; 
as required

Both 3 to 6 months Automated only

Table C-2 Suggested Tuning Solutions for AB SCIEX Triple Quad™ 4500 System

System Positive Negative
AB SCIEX Triple Quad 4500 system 2 × 10–6 M PPG (1:50) 3 × 10–4 NEG PPG

Table C-3 Suggested Tuning Solutions for AB SCIEX QTRAP® 4500 System

Q1 and Q3 LIT
Instrument Positive Negative Positive and 

Negative
AB SCIEX QTRAP 4500 
system

2 × 10–6 M PPG (1:50) 3 × 10–4 NEG PPG 1:100 Agilent mix

Table C-4 Q1 and Q3 PPG Positive Ion Scans

Instrument Masses
AB SCIEX Triple Quad 4500 
system

59.0 175.1 500.3 616.5 906.7 1254.9 1545.1 1952.4

AB SCIEX QTRAP 4500 
system

59.0 175.1 500.3 616.5 906.7 1254.9 1545.1 1952.4

Table C-5 Q1 and Q3 PPG Negative Ion Scans

Instrument Masses
AB SCIEX Triple Quad 
4500 system

45.0 411.2 585.4 933.6 1223.8 1572.1 1863.3 1979.3

AB SCIEX QTRAP 4500 
system

45.0 411.2 585.4 933.6 1223.8 1572.1 1863.3 1979.3

Table C-6 Masses and Polarity for the AB SCIEX QTRAP 4500 system (Agilent)

Instrument/ 
Polarity

Masses

LIT Positive 118.087 322.049 622.030 922.010 1521.972 – –

LIT Negative 112.985 431.982 601.978 1033.988 1633.949 – –
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D
Cleaning and Maintenance
Regularly clean and maintain the instrument for optimal performance. For information on tuning 
frequency, refer to Table C-1 Tuning Frequency on page 131.

The following table provides a recommended schedule for cleaning and maintaining the 
instrument. Contact your Qualified Maintenance Person to order consumable parts.

For “As needed” tasks, follow these guidelines:

• Clean the curtain plate, orifice plate, QJet ion guide, and Q0 region if system 
sensitivity degrades. 

• Clean the instrument surfaces after a spill, or when they become dirty.

• Empty the drain bottle when it becomes full.

Contact an AB SCIEX representative for maintenance service and support.

Health and Safety Precautions
• Determine what chemicals may have been used in the instrument prior to service. 

Refer to Safety Data Sheets for the health and safety precautions that must be 
followed with chemicals. 

• Work in a well-ventilated area. 

Table D-1 System Maintenance Tasks

Component Frequency Task For more information, refer to...
Curtain plate As needed Clean Clean the Curtain Plate

Orifice plate As needed Clean Clean the Front of the Orifice Plate

QJet® ion guide As needed Clean Contact an AB SCIEX FSE.

Q0 and IQ1 lens As needed Clean Contact an AB SCIEX FSE.

Instrument air 
filter

Every 6 
months

Inspect and 
clean or replace

Contact an AB SCIEX FSE.

Instrument 
surfaces

As needed Clean Surface Cleaning

Drain bottle As needed Empty Empty the Drain Bottle

Roughing pump 
oil

Leybold 
Sogevac SV 
28: Every 6 
months

Varian MS 30: 
Annually

Replace Dependent on roughing pump. Contact an 
AB SCIEX FSE.

Electrode As needed Inspect and 
clean or replace

Clean the Electrode Tube

Corona 
discharge needle

As needed Replace Replace the Corona Discharge Needle
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Cleaning and Maintenance
• Always wear assigned personal protective equipment, including powder-free nitrile 
gloves, safety glasses, and a laboratory coat. 

• Follow required electrical safe work practices.

• Avoid ignition sources when working with flammable materials, such as isopropanol, 
methanol, and other flammable solvents. 

• Take care in the use and disposal of any chemicals. Potential risk of personal injury if 
proper handling and disposing of chemicals are not followed. 

• Avoid skin contact with chemicals during cleaning, and wash hands after use.

• Comply with all local regulations for the handling of biohazard, toxic, or radioactive 
materials.

Caution: Potential Instrument Damage: Rinse off any acid-containing cleaning solvents 
with water. Do not use chlorinated solvents because these may damage the QJet ion 
guide components

Surface Cleaning
Clean the external surfaces of the instrument after a spill, or when they become dirty.

• Using warm, soapy water and a soft cloth, wipe the external surfaces.

Empty the Drain Bottle
Empty the drain bottle when it becomes full.

1. Shut Down the System.

2. Disconnect the tubes from the top of the drain bottle.

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard: 
Determine whether instrument decontamination is required prior to 
cleaning. Instrument decontamination should be conducted prior to 
cleaning if radioactive materials, biological agents, or toxic chemicals 
have been used with an instrument. 

WARNING! Biohazardous Material: Deposit biohazardous material in 
appropriately labelled containers. Potential risk of personal injury if proper 
handling and disposing of biohazardous materials are not followed
4500 Series of Instruments
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Cleaning and Maintenance
3. Unscrew the cap and dispose of the waste.

4. Replace the cap and connect the tubes.

Front-End Cleaning
Clean the instrument front-end using the routine cleaning method, to:

• Minimize unscheduled instrument downtime.

• Maintain optimum sensitivity.

• Avoid more extensive cleaning that requires a service visit.

Symptoms of contamination: Significant loss in sensitivity and increased background noise. 

When contamination occurs, perform an initial routine cleaning. Clean up to and including the 
front of the orifice plate. If routine cleaning does not resolve issues with sensitivity, a full cleaning 
may be necessary.

This section provides instructions for performing routine cleaning without breaking vacuum and 
full cleaning under atmospheric pressure, after venting the instrument.

Figure D-1 Drain bottle

Item Description

1 Connection to instrument.

2 Drain bottle (Drain bottle shown at the rear of the instrument to show 
connection points. The drain bottle is at the side of the instrument when 
installed.)

3 Connection to vent.

2

3

1
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Cleaning and Maintenance
Best Practices

• Always wear clean, powder-free gloves for the cleaning procedures. 

• After cleaning the instrument components and before reassembling them, put on a 
clean pair of gloves.

• Do not use cleaning supplies other than those specified in this procedure.

• If possible, prepare cleaning solutions just before beginning.

Note: Follow all applicable local regulations. For health and safety guidelines, refer to 
Health and Safety Precautions for more information.

Note: For consumables ordering information and inquiries, call 877-740-2129 (U.S. 
only), or visit www.absciex.com.

Required Tools and Materials
• Powder free gloves (nitrile recommended)

• Safety glasses

• Laboratory coat

• Fresh, high quality water (at least 18 Mohm de-ionized water [DI water] or ultra-pure 
HPLC-grade water). Old water can contain contaminants which can further 
contaminate the mass spectrometer.

• HPLC- or LCMS-grade methanol, isopropanol (2-propanol), or acetonitrile

• Cleaning solution. Use one of:

• 100% methanol

• 100% isopropanol

• 50:50 acetonitrile:water solution (freshly prepared)

• 50:50 acetonitrile:water with 0.1% acetic acid solution (freshly prepared)

Caution: Do not use chlorinated solvents.

Table D-2 Tools and Supplies Available from AB SCIEX

Description P/N
Small polyester swab (thermally bonded) 1017396

Small lint-free wipe (11 cm x 21 cm); available in Consumables kits WC018027

WARNING! Radiation Hazard, Biohazard, or Toxic Chemical Hazard: 
Determine whether instrument decontamination is required prior to 
cleaning. Instrument decontamination should be conducted prior to 
cleaning if radioactive materials, biological agents, or toxic chemicals 
have been used with an instrument. 
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Cleaning and Maintenance
• Prepare and store all organic solutions and organic-containing solutions in very 
clean glassware only. Never use plastic squirt bottles. Contaminants can leach from 
these bottles and further contaminate the mass spectrometer.

• Allow only the center area of the wipe to contact the instrument surface. Cut edges 
can leave fibers behind. 

Figure D-2 Example: Folding the wipe

• Allow the wipe or swab to contact the surface once, and then discard it, to avoid 
cross-contamination.

• Larger parts of the vacuum interface, such as the curtain plate, may require several 
cleanings, using multiple wipes.

• To avoid contaminating the solution, pour the solution on the wipe or swab.

• Only moisten the wipe or swab slightly when applying water or cleaning solution. 
Water, more so than organic solvents, may cause the wipe to deteriorate, leaving 
residue on the instrument.

Prepare for Routine Cleaning
In routine cleaning, clean the curtain plate and the front of the orifice plate. Routine cleaning can 
be performed while the instrument remains under vacuum.

1. Deactivate the hardware profile. 

2. Remove the ion source. Be sure to place the ion source in a safe location.

3. Wait at least 20 minutes for the curtain plate and orifice plate to cool. 

4. Cover the source drain with the exhaust cover plate (if available), or a similar cover. 

Tip! Wrap the wipe around a thermally-bonded polyester swab.

Note: Instruments with a NanoSpray® ion source may require a full cleaning for best 
results. Contact an AB SCIEX FSE.

WARNING! Hot Surface Hazard: Surfaces of the ion source become hot during 
operation. Let the ion source cool for at least 10 minutes before starting any 
cleaning procedures.
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Cleaning and Maintenance
Clean the Curtain Plate
1. Remove the curtain plate and then place it on a clean, stable surface.

Figure D-4 Interface with curtain plate removed

2. Using wipes and water, clean both sides of the curtain plate.

3. Repeat step 2 using the cleaning solution.

4. Using a dampened wipe or small poly swab, clean the aperture.

5. Wait until the curtain plate is dry.

6. Inspect the curtain plate for solvent stains or lint, removing any residue with a clean, 
slightly damp lint-free wipe.

Figure D-3 Source drain on the vacuum interface

Item Description

1 Source drain

1
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Cleaning and Maintenance
Clean the Front of the Orifice Plate

1. When cleaning a NanoSpray orifice plate, remove the interface heater and clean it:

i. Wipe the heater with a lint-free wipe dampened with water.
ii. Wipe the heater with a lint-free wipe dampened with cleaning solution.

2. Moisten the lint-free wipe with water and then wipe the front of the orifice plate. 

Caution: Potential Instrument Damage: Do not insert a wire or metal brush 
into the orifice, to avoid damaging the aperture.

3. Repeat step 2 using the cleaning solution. 

4. Wait until the orifice plate is dry.

5. Inspect the orifice plate for solvent stains or lint, removing any residue with a clean, 
slightly damp lint-free wipe.

Put the Instrument Back into Service
1. Install the curtain plate on the front end of the instrument.

2. Remove the protection from the ion source drain.

3. Install the ion source on the mass spectrometer. 

4. Tighten the ion source by turning the ion source release latches down into the 
locking position. (Refer to the ion source Operator’s Guide.)

5. Activate the hardware profile.

Note: Persistent spotting or filming is an indicator of contaminated solvent.

Note: If the standard orifice plate has a removable interface heater, do not remove the 
heater during cleaning.

Note: Persistent spotting or filming is an indicator of contaminated solvent.
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E
Basic System Troubleshooting
This appendix contains basic information for troubleshooting basic system issues. Certain 
activities may be carried out by the AB SCIEX trained Qualified Maintenance Person in the 
laboratory. For advanced troubleshooting, contact an AB SCIEX Field Service Employee (FSE).

For sales, technical assistance or service, contact an AB SCIEX FSE or visit the AB SCIEX Web 
site at www.absciex.com for contact information.

Table E-1 System Issues

Problem Possible cause Corrective action
Sensitivity loss Instrument or ion source 

requires tuning and optimizing
For more information, refer to:

• Instrument Tuning and 
Calibrating

• Turbo V™ Ion Source User 
Reference appendix

• Analyst® software Help 
system

Dirty curtain plate Refer to Clean the Curtain 
Plate for more information.

Dirty orifice plate Refer to Clean the Front of the 
Orifice Plate for more 
information.

Dirty QJet® ion guide, Q0 or 
IQ0

Contact an AB SCIEX FSE or 
your local AB SCIEX trained 
Qualified Maintenance Person.

Frequent or extreme 
contamination of the QJet ion 
guide

Curtain Gas™ flow rate is too 
low.

Verify, and if applicable, 
increase the Curtain Gas flow 
rate.

Low vacuum pressure Low roughing pump oil level. Check the roughing pump oil 
level, and add oil if necessary. 

Contact an AB SCIEX FSE or 
your local AB SCIEX trained 
Qualified Maintenance Person.
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